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For many users, the Adobe PDF printer driver is all there is to creating PDF files, and the thought of

opening Acrobat brings immediate panic. Workflow? Security? Annotations? Forms? Bookmarks?

Video? Adding functionality to your PDF files is not as difficult as it might seem. What features you

decide to add to a PDF file depend on what you do and what you want the PDF file to do.

CUSTOMIZING THE TOOLBAR
Adobe lets you customize Acrobat’s toolbar by placing on it icons for the options you use more often.

The default Acrobat toolbar is divided into two levels. The top level contains the basic icons Open,

Create PDF from Web Page, Save, Print, Open the Organizer, Attach a File, Email, and Search. Next to

these sit what Acrobat calls task buttons. These are pop-up buttons for the most common tasks that

are required in Acrobat: Create PDF, Comment & Markup, Send to Review, Secure, Sign, and Forms.

The bottom level of the toolbar contains buttons for the most common tools, such as the Text Select

tool, the Hand tool, and the Zoom tool, as well as common functions, such as Page Rotation and Help.

Right-clicking anywhere on the toolbar lets you add more tools to the toolbar or remove any that you

don’t need. There’s also an option to show or hide buttons’ text labels; this is very useful for new

users who are not yet familiar with these tools. Experienced users turn off these labels to free space

in the toolbar. Also, if you want to view a PDF by using the largest possible area of your screen, you

can press F8 to temporarily hide the toolbar. Pressing F8 a second time brings it back (see Figure

43.1). Similarly, pressing F9 temporarily hides the menu bar. In addition, you can move tool groups

freely around the screen or dock them to the toolbar.
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Figure 43.1
Acrobat lets you customize the
toolbar to suit your needs. You
can also move tool groups around
the screen to minimize cursor
“travel time.”

USING THE NAVIGATION PANE
Another important feature of Acrobat’s interface is the Navigation pane. The Navigation pane is nor-

mally hidden on the left side of the Acrobat document window, but you can make it visible by pulling

the discrete handle on the edge of the screen. The Navigation pane is divided in two sections. The

top section gives you access to the tabs Bookmarks, Signatures, and Pages, providing an easy way to
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navigate a PDF. (The Navigation pane is also available in the free Adobe Reader.) The bottom section

of the Navigation pane, when opened, spans the entire bottom of the Acrobat document window

and contains the tabs Attachments and Comments. These tabs allow you to keep track of external

files attached to a PDF file (yes, you can attach files) and of comments made to the PDF file during

collaboration sessions.

The Bookmarks Tab
The Bookmarks tab displays a list of bookmarked pages in a PDF document. Adding bookmarks to

long documents’ chapters or sections, for example, allows for faster browsing (see Figure 43.2). 

43

The Signatures Tab
The Signatures tab in Acrobat allows authorized users to verify a document’s integrity or give proof

of revision by adding a personalized digital stamp. The Signatures tab allows you to quickly browse

through the signatures that have been added to a document. Signatures can be made visible or

invisible when a document is to be printed. Invisible signatures show in the Signatures tab but don’t

obstruct the viewing of a document by showing in the page. We will review digital signatures at

more leisure in Chapter 42, “Working in a PDF in Acrobat.”

The Pages Tab
The Pages tab allows you to see thumbnails of all the pages in a PDF document for quick browsing.

Unlike the Bookmarks tab, which displays a list of only bookmarked pages, the Pages tab displays all

the pages in a document (see Figure 43.3), allowing for faster browsing through long documents.

You can also use the Pages tab to rearrange pages by dragging and dropping them to the order in

which you want them.

Figure 43.2
Bookmarks allow you to better
structure PDF documents.
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The Attachments Tab
Acrobat allows for external files to be attached to a PDF document in the same way that files can be

attached to email messages. When you send the PDF electronically, its attachment is embedded and

sent along as well. Because Acrobat only piggybacks these file attachments and doesn’t display

them, they can be in any format. The easiest way to add an attachment to a PDF file is by dragging

and dropping the file into the Attachments tab. Your peers can use the Attachments tab to view

and/or save the attached files in their original format (see Figure 43.4). 
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Figure 43.3
For documents of a graphic
nature, such as magazines or
photo albums, the Pages tab lets
you quickly navigate and preview
page thumbnails in different sizes.

Figure 43.4
Just like email attachments, exter-
nal files can be attached to a PDF.
The Attachments tab allows for
easy browsing and saving of these
files.
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The Comments Tab
The Comments tab displays a list of all the comments and annotations made to a PDF document. As

a job progresses, these annotations can be checked as completed, allowing for a smoother revision

flow (see Figure 43.5). If the document contains any invisible comments, you can use the Comments

tab to locate them; the icons for visible comments can always be seen on the page.

43

WORKING WITH MENUS
Acrobat’s menu bar is similar to those of other applications in that it provides an organized way to

access all the tools and options available. In addition, Acrobat has context menus, which are avail-

able via right-click (Windows users) or Control-click (Mac users). Context menus do not add more

options to Acrobat, but they display a selection of the most common tasks that are also available

through regular menus.

The File Menu
The File menu provides basic options to open, print, save, and close PDF files, plus some enhanced

related options:

• Open: Choosing File, Open displays the Open dialog, which you can use to select a PDF file to

open. You can also use the Open dialog to quickly convert files in other formats to PDF and dis-

play them in Acrobat. If a file in a supported format is selected through the Open dialog, the

Adobe PDF driver activates and converts the file to PDF format on-the-fly, so Acrobat can

open it.

• Create PDF: The Create PDF menu option offers several submenu choices for creating new

PDF files:

Figure 43.5
The Comments tab lets you
review comments made to a PDF
document, view a comment his-
tory, and add check marks or
reply to comments.

51_0789733676_ch43.qxd  8/17/05  10:38 AM  Page PDF:949



PDF:950 Chapter  43:  Understanding Menus and Options in Acrobat

• From File: You use this option to quickly convert a file in a supported format to PDF via the

Adobe PDF driver. Supported formats include AutoCAD (DWG), Bitmap (BMP, RLE, DIB),

CompuServe GIF, HTML (HTML, HTM, SHTML), Job Definition Format (JDF, MJD), JPEG

(JPG, JPEG, JPE), JPEG2000 (JPF, JPX, JP2, J2K, J2C, JPC), Microsoft Office (DOC, PPT, XLS,

RTF), Microsoft Project (MPP), Microsoft Publisher (PUB), Microsoft Visio (VSD), PCX, PNG,

PostScript (PS, EPS, PRN), Text (TXT, TEXT), and TIFF (TIF, TIFF) (see Figure 43.6).
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Figure 43.6
The Create PDF From File feature
supports many file types.

• From Multiple Files: This option opens the Create PDF from Multiple Files dialog, from

which you can select several files to combine into one new PDF. Selected files don’t need to

be all in the same format but can be in different formats, as long as they are supported. The

dialog also allows you to rearrange the order in which these individual files will be placed

within the new PDF. After the PDF has been created, Acrobat prompts you to give it a name

and save it in a location of your choice.

• From Scanner: This option allows you to scan images right into a new PDF file. If you’re

scanning text documents for editing, the Create PDF From Scanner command allows you to

activate the built-in Optical Character Recognition (OCR) engine to generate editable text. As

an added bonus, this dialog also allows you to import images saved in your digital camera or

any other TWAIN device.

• From Web Page: This option opens the Create PDF from Web Page dialog, in which you can

specify a URL address for Acrobat to look up and in which you can adjust the way that

Acrobat handles different elements in the web page. After you accept the settings and click

the Create button, Acrobat retrieves the page from the Web and converts it, using the Adobe

PDF driver. An Internet connection is required for this. If the web page is in your hard drive,

you can use the Browse button to navigate to its location.

• From Clipboard Image: If you have copied an image from Acrobat or another application to

the Clipboard, you can use this option to make it into a PDF file. This option doesn’t work

with text copied to the Clipboard, only with images. You can use it to quickly convert parts of

an Illustrator image, for example, into a PDF file.
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• Organizer: This option gives you access to the Organizer feature (see Figure 43.7). Using the

Organizer is a neat way to organize PDF files into collections, even if those files reside in differ-

ent folders on your hard drive. We will talk more about the Organizer in Chapter 44, “Working

with Advanced Acrobat PDF Files,” so we’ll only browse briefly through the Open menu options

related to it:

43

• Open Organizer: This option opens the Organizer window. Its three panes display files’ loca-

tions, descriptions, and thumbnail previews.

• Add to a Collection: This option allows you to quickly add an open PDF to an existing collec-

tion or to create a new one. Collections are virtual groups of documents you can create to

keep your projects organized. We’ll talk more about collections when we review the

Organizer in Chapter 44.

• Collections: This menu option displays a list of all collections currently existing in your com-

puter for easy access to the files they contain. You can also use this menu option to create a

new collection.

• Email: You can use this menu option to email an open PDF file to any address of your choice.

For this to work, you need to have a default email client selected in your machine. Windows

users need to choose Control Panel, Internet Options to do this. Clicking the Programs tab

allows you to select an email client from a list of all clients currently installed in your machine.

Mac users need to launch Mail, choose Mail, Preferences, click General and select the email

application of their choice in the Default Email Reader pop-up menu.

• Close: This option closes the current PDF file.

• Save: This option saves changes made to the current PDF file.

• Save As: You use this option when you want to save a copy of your current PDF file under a dif-

ferent name.

Figure 43.7
The Organizer.
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• Save as Certified Document: This option allows you to add a digital ID to a PDF file. Digital IDs

are the equivalent of digital “signatures” that you can use to authenticate and/or to encrypt a

document. We discuss digital IDs in greater detail in Chapter 42.

• Revert: Selecting this menu option discards all editing done to a PDF and reverts it to its last

saved state.

• Reduce File Size: With each new version of Acrobat, file compression algorithms have improved,

making PDF files smaller in size without compromising their quality or features. If you have a

PDF file created in an older version of Acrobat, using this option allows you to apply the newer

compression and reduce the file’s size. Keep in mind that by doing this, the file’s compatibility

with the version of Acrobat that created it will be lost, and it may become unreadable to that

version.

• Send for Review: If you have enabled email-based or online reviews in a PDF file, you can use

this option to submit the file. A dialog prompts you to enter your name and a valid email

address (see Figure 43.8). An Internet connection is required.
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Figure 43.8
The Identity Setup dialog appears
when you send a form for review
by email or through a web page.

• Form Data: When you’re working with electronic forms, the Form Data menu option gives you

access to some common procedures. We will review forms in more depth in Chapter 44. 

• Initiate Data File Collection Workflow: This option opens the Initiate Form Data Collection

Workflow Wizard, which you can use to set up your PDF form for data collection. From that

wizard you can specify the email addresses of the persons you want to send the form to, cus-

tomize an invitation message to go in the email, and send the PDF (see Figure 43.9).

• Create Spreadsheet From Data Files: After you’ve received forms back, you use this option

to collect the data received and create a spreadsheet with it. The data can also be saved in

comma-delimited TXT form and other formats.

• Import Data to Form: This option allows you to automatically bring data from a comma-

delimited TXT file into corresponding fields in a form.

• Export Data From Form: With this option you can extract the data from one form and save it

as an XML or text file. This option is different from Create Spreadsheet in that this option

extracts data from only one form.

51_0789733676_ch43.qxd  8/17/05  10:38 AM  Page PDF:952



PDF:953Working with Menus

• How To Collect Form Data: For users new to electronic forms, this option triggers the Help

chapter on how to collect and save data from forms.

• Document Properties: Clicking this option opens the Document Properties dialog, which dis-

plays basic information about the current PDF file and allows you to change or add more proper-

ties. These properties are stored in the document as metadata in XML format. The Document

Properties dialog contains the following tabs:

• Description: This tab shows and lets you edit basic information about a document, such as

title, author, subject, and keywords. It also displays additional information on creation and

modification dates, the program that was originally used to create it, the version of the PDF

engine that created it, page size, and more (see Figure 43.10).

• Security: This tab displays security settings and restrictions applied to the document. It also

allows you to change these settings and activate security features.

43

Figure 43.9
The Initiate Form Data Collection
Workflow Wizard guides you
through the steps required to
properly set up your form for data
collection.

Figure 43.10
The Description tab of the
Document Properties window
shows detailed information about
the PDF file.
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• Fonts: This tab displays a detailed list of the fonts that are used and embedded through the

document.

• Initial View: This tab lets you select options on how you want Acrobat or Reader to display

the PDF file when someone else opens it. You can choose to hide the menu bar and toolbars,

for example. You can also choose to have the document open on a specific page, to open any

tab from the Navigation pane, open the document in Full Screen mode, and more (see

Figure 43.11).
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Figure 43.11
You can customize the way your
document shows when opened in
Acrobat or Reader.

• Custom: If you need it, you can use this tab to add to a document more details that are not

present in other Document Properties dialog tabs.

• Advanced: This tab allows you to set a base URL to look up if your PDF file contains links to

several pages inside the same website. You can also associate the PDF file to a catalog index

file stored in your computer. This feature is useful when you’re doing a search through sev-

eral documents at once. You also set trapping and reading options in this tab.

• Print Setup or Page Setup: This option opens the standard Windows Print Setup dialog or Mac

Page Setup dialog, from which you can select any installed printer and adjust its properties to

print a file.

• Print: This option opens the Print dialog, which has many options. Besides selecting a printer

and defining what pages to print, the main panel shows a preview of the file’s pages and lets

you select auto-rotation if the pages are not all in the same orientation. Clicking the Advanced

button opens a new dialog that has many advanced features for professional press production,

such as selecting bleeds, printing color separations, determining halftone frequency and angle

for each color plate, printing in negative, positioning job information in the bleed area, using

advanced PostScript options, and much more (see Figure 43.12).
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• Print with Comments Summary: You use this option when you have documents that have been

commented and you want to print out these comments along with the document itself. There

are four different options here: Document and comments with connector lines on separate

pages, Document and comments with connector lines on single pages, Comments only, and

Document and comments with sequence numbers on separate pages. With any of these four

options, you can choose to print all the comments made to the document or only the most

recent ones.

• PrintMe Internet Printing: You use this option when you are on the road or away from your

desktop and you need to print a document. The PrintMe network gives you access to an array of

public printers around the world that you can use. Clicking this option opens a web page in

your default browser that guides you step-by-step in using the PrintMe network (see Figure

43.13). Using the network is not a free service, so be prepared to enter your credit card and

other billing information.

• History: The History command keeps track of the documents you have worked on recently and

displays the last five documents you saved.

• Exit or Quit: These options close Acrobat.

The Edit Menu
The Edit menu contains commands for cut, copy, and paste, for selecting items in the document, for

undoing other commands, for searching, for the Preferences window (in Windows; on the Mac, the

Preferences command is located in the Acrobat menu), and for checking spelling, among other

options.
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Figure 43.12
Clicking the Advanced button in
the Print dialog gives you access
to many specialized features for
press production.
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• Undo: This command allows you to go back one step at a time on changes made to a PDF file.

When a document is closed, these “memorized” states are deleted from the Undo memory. Undo

doesn’t work on changes made to the Document Properties window.

• Redo: This command allows you to reverse an Undo action. 

• Cut: This command removes selected text, tables, or images from the document and places

them in the computer’s Clipboard.

• Copy: This command copies the selected text and/or images to the Clipboard.

• Paste: This command pastes the contents of the Clipboard into a selected insertion point in a

comment (text only) or form field. If you want to paste an image from the Clipboard into a PDF

file, you should use the Paste Clipboard Image As Stamp tool. You can use Paste to place images

from the Clipboard into an existing blank page but not into pages that already have contents.

• Delete: This command deletes selected text, tables, or images from a document. This option

doesn’t make a copy of the deletion into the Clipboard.

• Copy File to Clipboard: This command copies the contents of an entire PDF file, including its

formatting, to the Clipboard.

• Select All: This command selects all the text in the current page.

• Deselect All: This command deselects any text or images that have been selected.

• Check Spelling: This option allows you to check spelling in comments and in the contents of

form fields added to a document. It also allows you to add new words to Acrobat’s built-in dic-

tionary. You can add personal names and company names, for example, to the dictionary so that

they are not tagged during a spell check.
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Figure 43.13
When you are traveling, you can
use the PrintMe network to locate
a public printer near you and send
your document to print.
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• Add Bookmark: This command adds a bookmark to a selected part of a page. The bookmark

appears in the Bookmarks tab.

• Lookup: This feature allows you to look up a selected word in an online dictionary. To use it,

you select a word or phrase by using the Select tool and then click Lookup. A browser window

opens, displaying the result of the lookup at www.dictionary.com. This feature works only with

English words, and an Internet connection is required. If a phrase is selected, the web page

shows the lookup on the first word in the selected phrase. You can also use Lookup by right-

clicking (Windows users) or Control-clicking (Mac users) any word in a document with the

Select tool and scrolling down to the bottom of the context menu.

• Find: This option activates the Find toolbar. You can use it to locate words or phrases in a docu-

ment and its comments.

• Search: This option opens the Search pane on the right of the Acrobat window. The Search

pane has more advanced capabilities than the Find toolbar; it displays a list of all matches

found, allows you to do case-sensitive searches, lets you search through all documents in a

folder (even if they are not open), and lets you search the Internet via the Yahoo! search engine

(see Figure 43.14).
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• Search Results: This command allows you to browse through the results of a search done in the

Search pane. It also lets you browse through searches done in multiple documents.

• Preferences: This option allows you to set preferences for Acrobat itself, not for the current doc-

ument. These preferences determine the way Acrobat handles and displays PDF documents.

(Note that in the Mac OS, the Preferences command is located in the Acrobat menu, to the left

of the File menu.) The following categories are available:

Figure 43.14
The Search pane provides
advanced search options.
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• 3D: This setting allows you to display or hide by default the 3D toolbar that appears when 3D

content has been added to a PDF document.

• Accessibility: This selection gives the option to globally set custom display colors for people

who have visual or mobile impairments. These settings complement those in the

Accessibility Setup Assistant (see Figure 43.15).
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Figure 43.15
Users who have visual impair-
ments can use the Accessibility
tab to change the way Acrobat dis-
plays color.

• Batch Processing: You can use this selection to set basic preferences when you are process-

ing a collection of documents at once. It allows you to create and save an error log file, for

example, or to use security features when opening the files in the collection.

• Catalog: This selection gives you access to and lets you edit the preferences you set when

creating a new indexing catalog. An index catalog is a list of text, images, comments, tags,

and other elements in a group of PDF documents. We will take a closer look at the Catalog

feature when we review the Advanced menu later in this chapter. 

• Color Management: You use this selection to tell Acrobat how to display colors in documents

that have no ICC (International Color Consortium) profiles embedded. These settings allow

Acrobat to better simulate the way colors will look when a document is printed. We take a

closer look at color management in Chapter 44.

• Commenting: In this selection you can set the default font, size, and opacity of fonts used in

comments. You can also set the way comments are displayed and/or handled.

• Convert From PDF: In this selection you can adjust settings for how Acrobat converts PDF

files to other formats when you use the Save As option. You can change settings for color,

vectors, fonts, and more for each of the formats supported under Save As.
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• Convert To PDF: Similarly to the Convert From PDF tab, this selection allows you to set indi-

vidual settings for file types supported under the Create PDF From File option.

• Forms: This selection allows you to adjust the way Acrobat displays fields and other interac-

tive elements in forms. You can also change the colors used to highlight form fields and turn

the Auto-Complete feature on and off (see Figure 43.16). This selection only adjusts form dis-

play and interaction in Acrobat, not how forms are edited or created. We will review

Acrobat’s form tools later in this chapter and will also take an in-depth look at form data col-

lection in Chapter 44.
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• Full Screen: You can use this selection to tell Acrobat how to behave and navigate a PDF

when it is shown in Full Screen mode. 

• General: Some generic settings are available on this selection, such as the number of min-

utes between autosaves, whether to automatically detect URL addresses in documents, and

whether to enable warnings. You can also turn Version Cue on and off.

• Identity: This selection allows you to customize your Identity settings. These settings are

used in comments, reviews, and digital signatures.

• International: You can change the default language for Acrobat on this selection, and you

can also change paragraph direction when using right-to-left languages.

• Internet: This selection lets you change the way Acrobat interacts with your browser when

you’re viewing PDF files over the Internet.

• JavaScript: On this selection, you can enable JavaScript in PDF files that have JavaScript

code (for example, PDF files created from web pages that contain JavaScript). You can also

choose to use the built-in Acrobat JavaScript editor or another editor of your preference.

Figure 43.16
Several options to display and
interact with forms are available
in the Preferences window.
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• Measuring: You can use this selection to set the tolerance levels for the Measuring tool (more

about this tool later in this chapter). You can also set colors for snap hints and choose

whether the Measuring tool uses the default measurement units or those specified when the

document was created. 

• Multimedia: You can use this selection when viewing a document with embedded video

and/or audio to set a preferred player for the media.

• Page Display: This selection contains the preferences for how Acrobat displays pages.

Among the options available are display of page layout, how to display large images, the

resolution at which to display images, text greeking, display of bleeds, and more (see

Figure 43.17).
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Figure 43.17
You can adjust the way Acrobat
displays pages, image resolution,
text greeking, and more. 

• Reading: You can use this selection to set preferences for external screen readers or the

built-in Read Out Loud feature. You can set volume, speed, which pages to read (whole docu-

ment or displayed pages only), and select a preferred voice.

• Reviewing: This selection lets you adjust options for using online reviewing in a document.

• Search: This selection is where you set preferences for the Search feature. You can choose to

ignore Asian characters or accents, for example, or set a maximum number of documents

returned when doing a Search on multiple documents.

• Security: The options on this selection allow you to select and/or create new digital signa-

tures to be used when certifying a PDF file or adding comments. Digital IDs and signatures

will be reviewed in Chapter 42.

• Spelling: On this selection you can activate or deactivate the automatic spell checker, change

the color used to underline misspelled words, and select one or more dictionaries to be used

for spell checking.
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• Startup: Several Startup options are available on this selection: the maximum number of

documents displayed in the Open Recent File submenu, how long a document can remain in

the Organizer history, whether to use or hide Acrobat’s splash screen at startup, what kind

of plug-ins to use, and more.

• TouchUp: This tab lets you select which programs to use to edit embedded images.

• Trust Manager: On this selection you can change security settings for documents with

embedded multimedia. You can determine whether a PDF file is allowed to launch external

applications to play attached files (see Figure 43.18).
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• Units & Guides: This selection allows you to set up measurement units for Acrobat’s rulers.

Settings for Acrobat’s grid and guides are also available here.

• Updates: You can allow Acrobat to automatically access the Internet and look for and install

updates. 

• Web Capture: You use this selection when converting web pages from the Internet to PDF

format. You can set URL links to open in Acrobat or in your default browser.

The View Menu
The View menu contains options to adjust Acrobat’s document window to better suit your needs

and likings:

• Navigation tabs: Besides the default tabs in the Navigation pane, Acrobat has many other tabs

to help you navigate a document. After activation, you can drag these tabs and dock them in the

Navigation pane together with the default ones. Or you can group them together or keep them

separate (see Figure 43.19). Each tab has different options, depending on what they display:

Figure 43.18
You can set permissions for exter-
nal multimedia viewers.
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• Articles: This tab displays all articles created in the document. You can use it to easily navi-

gate and follow articles that span several pages. 

• Attachments: This tab displays all files attached to the PDF document. 

• Bookmarks: This tab lists all the bookmarks set in a document. You can also use it to

delete existing bookmarks or to create new ones. Bookmarks are covered in more detail in

Chapter 42.

• Comments: This tab displays all the comments added to a PDF file. You can use it to navi-

gate through them, edit them, or manage them during a review process. We’ll take a closer

look at comments in Chapter 42. 

• Content: This tab displays an itemized list of all elements included in the PDF document,

separated by page. 

• Destinations: This tab shows a list of all Destinations links set in the PDF for easy navigation

through multiple documents. 

• Fields: This tab displays a detailed list of all fields present in a form. 

• Info: This tab displays the position of the cursor in the document at any time. If an image or

text is selected, Info also displays the width and length of the selected block. 

• Layers: If you chose to preserve layers when exporting an image or file to PDF, the Layers

tab displays those layers. You can make them visible of hide them, according to your needs. 

• Order: This tab shows the order in which contents flow through the document. Changing the

order of contents affects the way text is placed when exporting the PDF to TXT format. 

• Pages: This tab shows thumbnails of all pages in the document. 
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Figure 43.19
Navigation tabs can be separated,
collapsed, or docked to better fit
your needs.
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• Signatures: If signatures have been added to the document, this tab lists them. 

• Show/Hide Navigation Pane: This option maximizes viewing area by hiding the Navigation

pane and only leaving the tabs visible. 

•Dock All Tabs: This option docks all currently open tabs to the Navigation pane. 

•Reset All Tabs: This option closes all non-default tabs and removes them from the Navigation

pane.

• Task buttons: Task buttons contain shortcuts to specific features or tasks you can accomplish

with Acrobat. Six task buttons are available that you can hide or make visible in your taskbar.

By default, these task buttons are all visible in the top row of your taskbar. In addition, you can

choose to undock them and position them anywhere on the window. These are the six buttons:

• Create PDF: This button contains all the same five options found under the File menu. In

addition, it has an extra option to open the How To Create PDF section in the Help file. 

• Comment & Markup: This button contains a basic set of commenting tools that are also

found in the Comments menu. 

• Send for Review: This button contains the same options found under the File menu, plus a

link to the How To Send for Review section in the Help file. 

• Secure: This button shows the same options found under the Document, Security menu. 

• Sign: This button contains a few of the options found under the Document, Digital

Signatures menu, plus a link to the How To Sign section of the Help file. 

• Forms: This button contains a few of the options found under the Advanced, Forms menu,

plus three links to the Help file. 

• Toolbars: Similar in behavior to tasks buttons, the toolbars give you access to a wide array of

tools that you can use to edit a PDF document. Some of these tools can be found under the

Tools menu, and others are found under other menus. Task buttons are grouped on toolbars

to give you faster access to them than by pulling down menus. The following toolbars are

available:

• Advanced Editing: This toolbar contains tools for selecting, moving, and cropping objects;

creating paragraph flows and links; inserting multimedia files; inserting form objects; and

editing text. These tools can also be found under Tools, Advanced Editing. 

• Basic: This toolbar contains buttons for the basic tools needed to edit a document: the Hand

tool, Select tool, and Snapshot tool. By default, they are found on the bottom left of your

toolbar.

• Commenting: The Commenting toolbar contains some of the tools found under the

Comments menu, and you use it to add and edit comments to your document.

• Drawing Markups: In addition to the Commenting toolbar, the Drawing Markups toolbar is

also used to add commenting elements, such as cloud bubbles, arrows, callout boxes, and

dimension marks. These tools are also found under the Comments menu.
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• Edit: This toolbar contains a button to do spell checks on comments and markups, a Copy

button, and an Undo and Redo button.

• File: The File toolbar contains a set of tools found under the File menu to open, create, save,

and print files; plus Search, Email, and Attach File buttons. There’s also a button to open the

Organizer. By default, this toolbar is docked on the top left of your toolbar.

• Help: This toolbar allows you to open the Help file. It also contains links to the same sections

in the Help file that are found under the Help menu.

• Measuring: The tools on this toolbar are also found under the Tools, Measuring menu and

are useful to measure lengths, perimeters, and areas in a document.

• Navigation: This toolbar is not the same as the Navigation Tabs command. The Navigation

toolbar contains buttons to move forward or backward along the pages of a document or to

skip to the first or last page of the document.

• Object Data: This toolbar displays specific information about objects in a PDF created with

Microsoft Visio.

• Print Production: This toolbar contains the same tools found under the Tools, Print

Production menu, which are used for advanced prepress and press work.

• Rotate View: This toolbar contains two buttons to rotate a page’s view either clockwise or

counterclockwise. These options are also found under the View, Rotate View menu.

• Search the Internet: This one-button toolbar opens the Search pane on the right of the win-

dow, but it adds an option to look up a word or phrase on the Internet through your browser.

• Tasks: This toolbar toggles between showing and hiding the toolbar containing all six task

buttons.

• Zoom: This toolbar contains buttons set to the most common Zoom percentages; these

options are also found under the View menu.

• Menu Bar: This option hides the menu bar. You can press the F9 key (in Windows) or „-Shift-M

(on the Mac) to make it visible again.

• Full Screen: This option temporarily hides all panes, toolbars, menus, and active windows to

display a document at the maximum size allowed by the monitor. You can press the Esc key to

return to the Normal View mode.

• Zoom To: This option pops up a small dialog that lets you choose a percentage of magnification

for the document.

• Actual Size: Selecting this option resets the document zoom to 100%.

• Fit Page: This option resizes the document’s display so that a whole page fits in the screen.

• Fit Width: This option resizes the document’s display to the maximum possible width.

• Fit Visible: This option resizes the page so that all its text and images are visible, but it leaves

margins out of the window.
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• Reflow: This option shows how the PDF contents will

reflow when displayed on a handheld device or a small

monitor without having to be scrolled horizontally to be

read. Reflow follows the order of text and images set in

the Order tab (see Figure 43.20). 

• Automatically Scroll: This option allows you to scan

through long documents without having to click arrow

keys or drag the scrollbar. To change the scrolling speed,

you simply press a number key in your keyboard, where

0 is the slowest and 9 is the fastest. Pressing the minus

sign key or the hyphen key reverses the scrolling direc-

tion. To stop scrolling, you press the Esc key.

• Read Out Loud: This option activates the Read Out Loud

feature, which lets you listen to the contents of a page or

entire document instead of reading it. Read Out Loud

settings can be changed from the Reading options selec-

tion of the Preferences dialog (which you get to by

choosing Edit, Preferences in Windows or Acrobat or by

choosing Preferences on the Mac). You can also use this

option to pause or stop the reading of a document.

• Go To: This option allows you to quickly navigate

between pages in the document. These are the same

buttons that show in the status bar at the bottom of the

window.
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Figure 43.20
Reflow follows the order set in
the Order tab.

Read Out Loud is one of Acrobat’s
features to help persons with
visual disabilities. With this fea-
ture, any user can turn up the
computer volume and sit back,
letting Acrobat read a document.
Read Out Loud doesn’t require
any special software to be
installed; all you need is a pair of
speakers connected to your com-
puter through its sound output.
The feature comes with two voices
(a male and a female) that can be
selected on the Reading page of
the Acrobat Preferences dialog. In
addition, if you use Windows and
have text-to-speech software
installed that uses SAPI4 or SAPI5
voice engines, the voices from
those engines are also available
to Read Out Loud. Consult your
operating system manufacturer
for more information about its
support of speech technology or
to obtain additional voices for
Windows. 
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• Page Layout: This option lets you toggle between different ways to display page spreads. Page

Layout buttons are also shown on the right side of your status bar, in the bottom-right corner of

the screen.

• Rotate View: When you’re working with pages created at different orientations, this feature lets

you quickly rotate an entire page to make it easier for you to work with it, and it doesn’t affect

the way a document is printed.

• Grid: This option displays Acrobat’s grid to help you adjust the positioning of elements within

the document.

• Snap To Grid: A complement to the grid, this command activates the Snap feature for better

alignment of elements (see Figure 43.21).
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Figure 43.21
Snapping elements to the grid
helps you keep elements aligned
when editing a document.

• Rulers: This option displays horizontal and vertical rulers along the top and left edges of an

Acrobat document window. Right-clicking (Windows users) or Control-clicking (Mac users) the

rulers allows you to quickly change measurement units and turn grid and guides on and off.

• Guides: Guides are horizontal or vertical lines you can drag from the rulers as visual aids.

Guides don’t show in Full Screen mode, nor do they appear when a document is printed. You

can use the Guides option to temporarily hide or make guides invisible.

• Wireframe: If a document contains vector elements, the Wireframe command changes their dis-

play to a uniform stroke width of 1 pixel for faster display. This doesn’t affect photos or text, and

it doesn’t affect the way a document prints.

• Tracker: This option opens the Tracker window, which allows you to keep track of comments

and reviews made to a PDF file. We discuss the Tracker window in more detail in Chapter 42.

• Show Comments List: This option opens the Comments tab at the bottom of the Acrobat docu-

ment window.
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The Document Menu
The Document menu contains some general options for adding security and handling pages in a

document:

• Attach a File: This option opens the Add Attachment dialog, which you can use to browse

through your computer and locate files to attach to a document. If a document contains an

attachment, a paperclip icon appears in the status bar. Attached files are listed in the

Attachments tab.

• Add Headers & Footers: This option opens a dialog you can use to customize and insert up to

three headers and three footers to a document (see Figure 43.22). We will review this feature at

more length in Chapter 42.

43

• Add Watermark & Background: You use this option to add custom watermarks or backgrounds

to a document. Watermarks and backgrounds can be text or images (see Figure 43.23).

• Digital Signatures: From this submenu, you can sign a document by using a digital signature,

create or delete signature fields, verify signatures in a document, and more (see Figure 43.24).

• Security: This submenu gives you access to several options related to protecting PDF docu-

ments with existing security policies. You can also use this submenu to show the current secu-

rity settings for the document or to access a wizard to create new security policies to use in

your documents.

• Recognize Text Using OCR: This option opens the Recognize Text dialog, where you can select

OCR preferences and initiate an OCR scan.

Figure 43.22
You can add headers and footers
to a document without difficulty.
The Preview window shows how
they will display before you
accept the settings.

51_0789733676_ch43.qxd  8/17/05  10:38 AM  Page PDF:967



PDF:968 Chapter  43:  Understanding Menus and Options in Acrobat

• Compare Documents: This option opens the Compare Documents dialog, which allows you to

select two files and run a comparison to identify differences between them. You can select

between visual or text differences and how you want any differences found to be reported (see

Figure 43.25).

• Set Page Transitions: You can use this option to add slideshow-type transition effects to docu-

ments. Transitions show only when a document is viewed in Full Screen mode.

• Insert Pages: With this option, you can insert pages from an existing file in PDF or other sup-

ported format into the currently open document. If you need to add blank pages to a document,

you can quickly create a blank page file in Illustrator, save it as a PDF file, and use this option to

insert it.
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Figure 43.23
Watermarks and backgrounds can
be text or images. Settings such
as size and transparency are
available.

Figure 43.24
You can sign a document to certify
its origin or you can create blank
signature fields for your peers to
sign in and verify that they have
received it.
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• Extract Pages: You can use this option to extract pages from a current document to be saved as

new PDF files. You are given the option to delete the extracted pages from the current file.

• Replace Pages: You can use this option to replace one or more pages in a document with pages

from another one. Bookmarks and links are not affected.

• Delete Pages: This option quickly removes pages from a document.

• Crop Pages: You can use this option to crop pages and set trim and bleed boundaries for press

production. You can apply these settings to individual pages or to entire documents (see

Figure 43.26).

43

Figure 43.25
The Compare Documents feature
allows you to quickly verify
whether a document has been
altered.

Figure 43.26
The Crop Pages dialog gives you
advanced options to set up crops
and bleeds for press production. 
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• Rotate Pages: With this option you can rotate pages in 90-degree increments. You can rotate

specific pages or all the pages in a document. Unlike Rotate View, Rotate Pages affects the way

a page is printed.

The Comments Menu
The Comments menu contains all the tools that Adobe has implemented to allow Acrobat users to

participate in review sessions and insert comments and markups into a PDF file. These comments

are modeled after the way markups are done in a traditional print workflow environment. Comments

exist in a separate layer in the PDF file and do not alter the document’s layout or design. The follow-

ing commands are available on the Comments menu:

• Add a Note: Notes are the equivalent of sticky notes that can be attached anywhere on a page.

You can use them to add general comments. Notes minimize automatically when they are not

focused on (see Figure 43.27).
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Figure 43.27
A note has its own pointers and
displays detailed information such
as who wrote it and when.

• Text Edits: This command provides options for editing text in a document. With Text Edits you

can replace words or phrases, highlight segments, add specific comments to selected words,

and cross out and highlight words.

• Commenting Tools: This command provides a set of tools that you can use to mark up a file.

You can right-click (Windows users) or Control-click (Mac users) to gain access to the tools’ prop-

erties so that you can edit their color, transparency, and other formatting. The following tools are

available through the Commenting Tools command:

• Note Tool: Similarly to the Add a Note command, this one lets you drag the cursor to create a

note of any size you like anywhere you like. Notes created this way behave exactly the same

as ones created with the Add a Note command.
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• Indicate Text Edits Tool: You can use this command to select the place where a text edit is

to be inserted.

• How To Indicate Text Edits: This command opens the Help file page that corresponds to the

Text Edits tools.

• Stamp Tool: Clicking anywhere on a document with this command applies the equivalent of

a rubber stamp (see Figure 43.28). The last stamp used remains loaded in the Stamp tool.

Use the Stamps command (see the next point) to load new stamps. After a stamp has been

applied to a page, you can click it with the Select tool to resize the stamp, or you can access

its context menu (right-click the stamp in Windows or Control-click on the Mac) to change its

color and transparency level.

43

• Stamps: This command offers you an array of stamps in different colors and with different

messages to use with the Stamp tool. You can also choose to create your own custom stamps

with imported images and your own message. In addition, you can activate a Stamp palette,

from which you can browse through all existing stamps and then drag-and-drop stamps onto

a document (see Figure 43.29). When you select a stamp from the Stamps command, the

stamp is automatically placed on the page. To apply copies of the same stamp (to different

pages, for example), you use the Stamp tool.

• Highlighting: This command gives you three tools you can use to highlight, cross out, or

underline text. After text has been highlighted, you can right-click (in Windows) or Control-

click (on the Mac) it to edit the color and transparency level.

• Show/Hide Highlighting Toolbar: This command toggles the Highlighting toolbar on and

off. From this toolbar you can select any of the three highlighting tools.

Figure 43.28
The Stamp Tool command places
the equivalent of rubber stamps
on a document.
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• Attach a File as a Comment: This command allows you to click anywhere on a page and

attach a file. A small thumbtack icon shows where a file has been attached. Files attached

this way show in the Attachments tab.

• Record Audio Comment: Instead of writing a note, you can choose to record a voice message

and attach it to a PDF file by using this tool. You need a microphone to use this option. You

can also attach a prerecorded audio message in WAV or AIF format. Audio comments are

embedded in the PDF file (see Figure 43.30).
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Figure 43.29
You can create your own custom
stamps.

Figure 43.30
You can record a custom voice
message and attach it as a
comment.
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• Drawing Markup Tools: This command allows you to draw markups on the page as an aid in a

document’s revision process. Right-clicking (Windows users) or Control-clicking (Mac users)

them lets you adjust their individual preferences for color, size, transparency, and more. The fol-

lowing tools are available through the Drawing Markup Tools command:

• Callout Tool: You can use this tool to create callouts. Like the notes we reviewed earlier,

callouts also look like sticky notes but, unlike notes, they don’t minimize themselves and are

always visible. 

• Cloud Tool: You can use this tool to draw a cloud outline and give emphasis to your markups

or notes.

• Drawing: The Drawing command lets you draw freehand on your document. You can write;

draw boxes, circles, arrows, or polygons; or use the pencil tool and just doodle.

• Show Drawing Toolbar: This command toggles the Drawing toolbar on and off.

• Dimensioning Tool: This command lets you draw dimension lines across the page.

• Text Box Tool: You can use this command to draw text boxes, which are similar to callout

boxes but without arrow pointers.

• Show/Hide Commenting Toolbar: This command toggles the Commenting toolbar on and off.

• Show/Hide Drawing Markups Toolbar: This command toggles the Drawing Markups toolbar on

and off.

• Show/Hide Comments List: This command toggles the Comments tab on and off.

• Show Comments and Markups: This command gives you several sorting options for displaying

markups (see Figure 43.31).

43

• Send for Review: This command is the same as the Send for Review option in the File menu.

• Send Review Reminders: If you have initiated an email-based review, you can use this com-

mand to send all participants an email reminding them of an impending deadline.

Figure 43.31
There are many ways to sort and
display comments and markups
made to a document.
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• Enable for Commenting in Adobe Reader: After you’ve finished preparing a document, you can

use this option to enable the PDF file to be commented with Adobe Reader.

• Tracker: Tracker is a comprehensive dialog that allows you to keep track of a review process.

We discuss Tracker at leisure in Chapter 42.

• Export Comments: This command allows you to export the comments made to a PDF file into a

separate file for revision. Comments exported don’t contain the PDF file itself (only the com-

ments) and are saved in a special FDF file.

• Import Comments: If you are not part of an email- or web-based review and you need to see

comments made to a PDF file, you can use this option to import and view the comments saved

in a FDF file. You can also import comments directly from other PDF files.

• Migrate Comments: Sometimes you need to double-check previous comments against an

updated document. You can use this command to import comments from a previous version of a

PDF file after it has been revised and comments have been removed or edited.

• Summarize Comments: This command is similar to the Print with Comments Summary com-

mand found under the File menu. With Summarize Comments, you can create a new PDF file

that shows these summarized comments the same way they are printed (see Figure 43.32).
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Figure 43.32
You can create a new PDF file that
summarizes all comments.

• Print with Comments Summary: This is the same command found under the File menu.

• Commenting Preferences: Clicking this command opens the Commenting section in the

Preferences window, as found under the Edit menu.

• How to Comment & Markup: This command opens the corresponding page in the Help file.
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The Tools Menu
The Tools menu contains basic and advanced tools for editing a PDF document and setting up press

production options:

• Commenting: This command gives you access to the same commenting tools you can access

via the Comments menu.

• Drawing Markups: This command gives you access to the same drawing markups tools you can

access via the Comments menu.

• Basic: This command gives you access to tools for basic handling of a document:

• Hand Tool: You can use this command to “grab” a document and move it around the

window.

• Select Tool: You can use this command to select text, images, or comments in a document.

• Snapshot Tool: You can use this command to select an area of a document and capture an

image of it into the Clipboard.

• Zoom: You can use this command to zoom in or out of the document, according to your needs.

The maximum magnification possible is 6400% and the lowest is 8.33%. The Zoom command

gives you the following options:

• Zoom In: You use this option to increase the page magnification.

• Zoom Out: You use this option to decrease the page magnification.

• Dynamic Zoom: With this option selected, you can move the cursor upward to increase mag-

nification or downward to decrease it. If you use a wheel mouse, moving the wheel up

increases magnification and moving it down decreases it.

• Loupe: This option opens a small window that displays an enlarged view of a selected area

in the document. You can adjust the amount of magnification by dragging the corners of the

area box or by moving the slider in the tool window (see Figure 43.33).

• Pan and Zoom Window: This option opens a small window that displays a full page and a

frame around the current visible area. You can move that frame around to pan around

the document or you can drag its corners to increase or decrease magnification (see

Figure 43.34).

• Hide Zoom Toolbar: You use this option to toggle the Zoom Toolbar on and off.

• Advanced Editing: The Advanced Editing command allows you to add multimedia functionality

and form objects to a PDF file. Data collected with text fields, radio buttons, list boxes, combo

boxes, check boxes, and buttons can be exported to spreadsheet format for evaluation. You will

learn how to collect data from forms in Chapter 44. This command provides the following sub-

menu options:
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• Select Object Tool: You use this command to select advanced elements such as links, form

fields, and multimedia objects placed in a document. Dragging this tool across a page also

temporarily makes visible any hidden notes and callouts.

• Article Tool: You use this command to determine the reading order of a document by drag-

ging consecutive bounding boxes around blocks of text. The Read Out Loud feature follows

this order.

• Crop Tool: You use this command to crop an area of a page. Everything outside that area

gets removed. This tool works the same as the Crop feature under Document, Crop Pages. 
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Figure 43.33
The Loupe tool.

Figure 43.34
The Pan and Zoom Window resem-
bles the Navigator feature in
Photoshop, Illustrator, and
InDesign.
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• Link Tool: This command creates hyperlinks from any

selected point in a document to another page, a point

in another document, or a web address.

• 3D Tool: You use this tool to draw a placeholder box

and insert 3D contents into a document.

• Button Tool: With this command you can add buttons

to a document and have them execute different

actions, such as jump to a specific page or play,

pause, or stop a placed movie or audio file (see

Figure 43.35).

• Check Box Tool: This command allows you to insert

check boxes to collect data. You can customize their

color, size, and shape, and you can attach pop-up

messages to them.

• Combo Box Tool: This command inserts a customiz-

able pop-up menu. You can edit font, color, borders, and size and collect the generated data.

43
There are times when you want to
use some form elements (check
boxes, radio buttons, text fields,
and so on) as part of a PDF docu-
ment, as in a small survey in an
electronic magazine, for example.
For situations like this, Acrobat
comes with a toolchest of form
elements that can be easily
applied to a page. These elements
can be used to add some interac-
tivity to a document or to create
entire forms that can be printed
and/or submitted electronically.

• List Box Tool: This command inserts a customizable list of selectable items (see

Figure 43.36).

• Radio Button Tool: You use this command to place clickable radio buttons on a page.

• Text Field Tool: You can add text fields to a document by using this command.

• Digital Signature: This command lets you draw an area into which to place a digital signa-

ture. You’ll find more information about digital signatures in Chapter 42.

Figure 43.35
You can use pictures as buttons.
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• Show Forms Toolbar: This command toggles the Forms toolbar on and off.

• Movie Tool: You use this command when you want to add a video file to a document. Video

added this way can be played inside the page.

• Sound Tool: Similar to the Movie Tool command, the Sound Tool command lets you add a

customizable box as a container for sound files.

• TouchUp Text Tool: You use this command to do minor text editing in a document. The font

used in the text to be edited must be present in the computer where the editing is being

done. For major retyping, it’s better to use the application where the PDF was created.

• TouchUp Reading Order Tool: When a document has been tagged for accessibility, you can

use this tool to edit the tags or rearrange their order. To select an area to tag, you simply

drag a rectangle around it with this command and click the corresponding type of contents in

the TouchUp Reading Order Tool dialog. The area appears as a tag in the Order tab (see

Figure 43.37).

• TouchUp Object Tool: You use this command to select placed images that require editing

with an external program.

• Show TouchUp Toolbar: This command toggles the TouchUp toolbar on and off. The

TouchUp toolbar contains the three TouchUp tools you can use for content editing.

• Show Advanced Editing Toolbar: This command toggles the Advanced Editing toolbar on

and off.

• Measuring: This command provides tools that help you find physical measurements of objects

and areas in a document:
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Figure 43.36
Combo and list boxes are easy to
set up in Acrobat.
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• Distance Tool: You can select start and end points with this command to find the exact dis-

tance in the measurement units of your choice. The Ortho option snaps the tool for exact

horizontal or vertical measurements.

• Perimeter Tool: Instead of measuring straight lines, you can use this command to draw rec-

tangles or irregular shapes to measure (see Figure 43.38).
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Figure 43.37
The order set with the TouchUp
Reading Order Tool command
changes the way Read Out Loud
navigates through the page.

• Area Tool: Similar to the Perimeter Tool command, the Area Tool command calculates the

total area covered by a shape.

Figure 43.38
The Perimeter Tool command
can measure the angles of
drawn lines.
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• Print Production: You use this command when you’re preparing a document for high-quality off-

set reproduction. The Print Production tools add very sophisticated control over the way docu-

ments are reproduced and are essential to a successful

PDF-based print workflow. We discuss the Print

Production command in more depth in Chapter 44, so for

now let’s just take a quick overview at the commands

available in this submenu:

• Trap Presets: Due to the way inks are applied when

printing color in an offset printing press, sometimes a

thin gap appears between two areas of different col-

ors. To prevent that from happening, you can apply

traps, which are very thin lines of overlapping inks applied to critical areas to prevent

gaps from appearing. Acrobat provides a comprehensive way to customize traps (see

Figure 43.39).

43

Enabling the Measurement
Markup check box for any of the
Measurement tools makes the
tool generate a markup box con-
taining the measurements taken
and a customizable message.

Figure 43.39
Customizing and saving your own
trapping presets is easy to do in
Acrobat.

• Output Preview: With this command, Acrobat simulates how a document will look when

printed and displays possible trouble areas (see Figure 43.40).

• Preflight: The Preflight command runs a series of diagnostics on a file to identify any incom-

patibilities that may arise. You need to select what kind of output the file is intended for, and

Acrobat runs its test based on that selection.

• Convert Colors: Sometimes a file contains images or objects in color models that are not

appropriate for reproduction. The Convert Colors command, which opens the Convert Colors

dialog, helps you convert these objects to a color model suitable for the intended output.
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• Ink Manager: The Ink Manager command allows you to see and change density values for

inks in the printing process. Unless you are an experienced commercial printer producing

print plates from PDF files, you should avoid changing the default values in the Ink Manager.

• Add Printer Marks: With this command, you can add marks required on printing plates for

press registration and proofing.

• Crop Pages: This is the same command found under the Document menu.

• Fix Hairlines: If a document contains objects with very thin lines or borders, those lines

might not print properly. The Fix Hairlines command helps you adjust the minimum width of

these thin lines.

• Transparency Flattening: Sometimes documents contain vector objects with transparency

values. In the Transparency Flattening dialog, which you open by selecting the

Transparency Flattening command, you can tell Acrobat how to handle those objects at

print time.

• PDF Optimizer: During print production, smaller files are processed faster than large ones.

This command allows you to change parameters such as image compression levels, font

embedding, compression of scanned images, and more, in order to reduce the size of a file

(see Figure 43.41).

• JDF Job Definitions: A job definitions file (JDF) is a small file that contains some production

information about a PDF file; it is the equivalent of a traditional job ticket. Data such as type

of stock to be used, number of copies to be printed, type of binding to be used, and so on is

contained in these files. Press operators look up and load these files to presses in order to

know how to handle a job (see Figure 43.42).
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Figure 43.40
You can see how each color plate
will print.
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• Show/Hide Print Production Toolbar: This command toggles the Print Production toolbar on

and off.

• Object Data Tool: If a PDF file contains elements created in Microsoft Visio, you can use the

Object Data Tool command to view details about the object.

43

Figure 43.41
The PDF Optimizer command is a
precision tool for managing com-
pression and compatibility of a
document. 

Figure 43.42
Creation of job definitions files is
easy in Acrobat.
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The Advanced Menu
The Advanced menu contains options to further customize or process a document:

• Accessibility: The Accessibility command helps you prepare a document for people who have

visual or motor disabilities.

• Change Reading Options: You use this command if you have a third-party screen reader

program installed and wish to adjust its settings. If you don’t have one, this option remains

grayed out.

• Quick Check: Clicking this option prompts Acrobat to run a fast check on a document’s accessi-

bility options to spot any possible problems.

• Full Check: This option opens the Accessibility Full Check dialog, where you can set parame-

ters for Acrobat to perform a thorough check for accessibility conflicts in the document. You can

choose for Acrobat to generate a report in text format and/or add comments to elements in the

page that are not accessibility friendly. You can also tell Acrobat to include or skip different

options for the check (see Figure 43.43).

43

• Open Accessibility Report: With this command you can have Acrobat open a previously saved

Accessibility report. The report is displayed in the right pane of your Acrobat window (see

Figure 43.44).

• Add Tags to Document: If a document hasn’t been tagged for accessibility, you can tag it by

using this command. Tags define the order and hierarchy of elements in a document. If a docu-

ment has already been tagged, this option remains grayed out (see Figure 43.45).

Figure 43.43
You can have Acrobat check only
determined pages in a document.
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• TouchUp Reading Order: This is the same command found under Tools, Advanced Editing.

• Setup Assistant: This command opens the Accessibility Setup Assistant, which guides you

through the steps of setting global accessibility options.

• Acrobat Distiller: This command opens Acrobat Distiller. We discuss Distiller in Chapter 45,

“Using Distiller.”

• Batch Processing: When you need to do the same editing in or run checks on several docu-

ments, you can use the Batch Processing command to automate that task. Batch sequences are

43

Figure 43.44
The Accessibility report shows a
detailed list of problems encoun-
tered during a full check.

Figure 43.45
Tags are listed in the Tags tab for
easy editing.
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macros that run common tasks through a group of documents. Unlike the actions found in

Photoshop, which are also macros, batch sequences don’t need to be recorded step-by-step.

The Batch Sequences dialog comes with several preset sequences you can choose from. You can

have a sequence add a watermark to all pages in all documents in a folder, for example, and run

a preflight check at the same time. You can also create and save your own custom sequences

by choosing from an extensive list of commands. After selecting a sequence, you can have

Acrobat overwrite the processed documents or save them in a new folder of your choice (see

Figure 43.46).

43

• Catalog: A catalog is a special type of file that Acrobat uses to index keywords found in a docu-

ment. Acrobat uses these entries when performing a search through the document. You can

have several documents in a project or an entire folder or group of folders included in one cata-

log. You can also use the Catalog command to open and rebuild an existing catalog.

• Digital Editions: Clicking this option opens the My Digital Editions window. Adobe digital edi-

tions are eBooks—PDF files that have been specially encoded. These eBooks can be purchased

online from many ebook vendors or borrowed from public libraries. A code is required to open

an ebook. You can use the My Digital Editions window to display thumbnails of your current

collection. In addition to digital editions, you can also add regular PDF documents to the list

(see Figure 43.47).

• Export All Images: This option lets you extract and export all raster images in a document to a

folder of your choice. Exported images can be saved in JPEG, TIF, or PNG format. You can

adjust settings for resolution, color mode, and compression.

• Forms: This option contains several commands to create or edit electronic forms. We review

forms in Chapter 44. 

Figure 43.46
You can select commands to add
to a custom sequence.
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• JavaScript: This option gives you access to Acrobat’s JavaScript Debugger and the JavaScript

Editor. JavaScript is discussed in Chapter 42.

• Links: This option allows you to automate the creation of links in a document. If a document

contains URLs, you can click Create from URLs in Document to have Acrobat automatically gen-

erate links throughout the whole document or only in elected pages. Acrobat uses the settings

in the Links command to display these links. If you need to delete links from a document, you

can use the Remove All Links from Document option.

• Migrate Comments: This is the same command found under the Comments menu.

• Number Pages: With this option, you can add custom numbering to parts of a document. If a

document is divided into sections, for example, you can renumber pages at the beginning of

each section. This numbering shows only in the Pages tab and in the status bar and doesn’t

affect the physical page numbering of the document.

• PDF Optimizer: This is the same command that shows under Tools, Print Production.

• Security Settings: This command opens the Security Settings window to manage your

digital IDs. 

• Trusted Identities: This command opens the Manage Trusted Identities dialog. Security, digital

IDs, and trusted identities are covered more extensively in Chapter 42.

• Web Capture: This command gives you several options to choose from that allow you to bring

web pages into a document. An Internet connection is required. These are the options under the

Web Capture command:

• Append Web Page: This option allows you to import the contents of a web page, convert it

to PDF format, and add it to an existing open document. You can choose to import only the

page in the URL entered or also pages that are linked in it (see Figure 43.48). Some settings

43

Figure 43.47
My Digital Editions is like a virtual
bookshelf that can list your PDF
documents and ebooks, organized
by categories.

51_0789733676_ch43.qxd  8/17/05  10:38 AM  Page PDF:986



PDF:987Working with Menus

are available for the handling of images imported this way. Checking the Save Refresh

Commands check box enables the captured page to be refreshed.

43

• Append All Links in Page: If a document contains links, you can use this option to pull the

linked pages from the Web and add them to the document. A status window shows the

download progress.

• View Web Links: This option presents a list of all links in a document. From this list you can

select links to bring into your document.

• Refresh Pages: With this option you can make sure that captured web pages are always up-

to-date. Clicking Refresh Pages prompts Acrobat to look up and download the web page

again and save it as a fresh PDF file. In this new document, any pages that have changed

since the previous capture or refresh are bookmarked (see Figure 43.49). Refresh Pages is

not available if the Save Refresh Commands check box was not checked during the original

capture.

• Page Info: This option displays the title of the HTML page, its original URL, and the date it

was captured.

• Open Page in Web Browser: This option opens the originating URL in your default browser.

• Bring Status Dialog to Foreground: When you are capturing large websites, the Status dia-

log moves to the background so that you can continue working on the document. If you want

to check on the download progress, you can use this option to bring the Status dialog back

to the foreground.

• Use Local Fonts: This command tells Acrobat to substitute embedded fonts with fonts presently

installed on your computer. If a font embedded in a PDF file has no equivalent in your computer,

the corresponding text shows as bullets.

Figure 43.48
You decide how many levels of a
website Acrobat captures. 
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• Overprint Preview: Overprints are areas where two or more areas with different inks overlap

each other. Overprint Preview causes Acrobat to simulate the way these areas will appear when

printed in an offset process.

• Output Preview: This is the same command that appears under Tools, Print Production.

• Preflight: This is the same command that appears under Tools, Print Production.

The Window Menu
The Window menu contains standard operating system options for viewing multiple documents, plus

some additions that are unique to Acrobat. The New Window, Cascade, Tile, Close All, and Split

commands are all standard operating system window options found in the Window menu. The fol-

lowing Window menu options are specific to Adobe Acrobat:

• Spreadsheet Split: This window option creates a four-pane grid that allows you to see different

areas of a document at once.

• Clipboard Viewer: This a Windows-only option that allows you to view the contents of text or

images copied to the Clipboard.

• Full Screen View: This is the same option found under the View menu.

The Help Menu
The Help menu gives users quick and easy access to Acrobat’s built-in Help features:

• How To: This command opens the How To pane.

• Complete Acrobat 7.0 Help: This command opens the Acrobat Help file.
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Figure 43.49
Acrobat automatically generates
bookmarks for pages that have
changed since the last refresh.
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• About Acrobat 7.0 Professional: This command displays the Acrobat splash screen in Windows.

The equivalent command on the Mac is About Acrobat, found in the Acrobat menu to the left of

the File menu.

• About Adobe Plug-Ins: This command opens a dialog that displays a list of all Adobe PlugIns

currently installed on your Windows computer. If you use a Mac, this command is located in the

Acrobat menu to the left of the File menu.

• System Info: This command displays a detailed view of your computer’s specifications. This

command is not available as an Acrobat menu option on the Mac; it appears as the About This

Mac command in the Apple menu.

• Adobe Expert Support: This command opens the Adobe Expert Support section of Adobe’s

website in your browser. That web page guides you through the registration process to Adobe’s

premium support services. An Internet connection is required.

• Online Support: This command opens the Adobe Acrobat support area of Adobe’s website in

your browser. That searchable page contains many help and support papers that you can

browse through in case of trouble. An Internet connection is required to use this option.

• Check for Updates Now: Clicking this option prompts the Acrobat auto-updater feature. If an

Internet connection exists, this command connects your computer to the Adobe website and

looks for, downloads, and installs any updates that are available for your software.

• Activate Acrobat: You can use this command to activate your copy of Acrobat through the

Internet after installation in Windows. Activation adds key information to your Windows

Registry and is required before you can use any of the CS2 programs. If you have already acti-

vated it, this option is grayed out. This command is not present in the Mac version of Acrobat.

• Transfer Activation: If you have purchased only one license to use CS2 but need to use Acrobat

or another CS2 program in more than one machine—for example, on your office PC during the

day and on your home PC at night—the Transfer Activation command (Windows only, Internet

connection required) allows you to temporarily deactivate Acrobat and all other CS2 programs

from one machine so that you can use them in the other one. Deactivating Acrobat and other

CS2 programs does not uninstall them from your computer but prevents their use on that

machine until they have been activated again. Deactivating removes key entries in your

Windows Registry that link the suite to your unique CS2 serial number. After you have deacti-

vated CS2, you can complete the transfer by activating it on another computer using the

Activate Acrobat command. 

• Acrobat Online: This option opens the main Acrobat web page in your browser. An Internet

connection is required.

• Accessibility Information Online: This option opens the Accessibility page of Adobe’s website

in your browser. An Internet connection is required.

• Detect and Repair: You can use this option if you are having problems with your installation of

Acrobat and want to restore it to its initial installed state. Your Adobe CS2 DVD is required to

complete any repairs.

43
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USING KEYBOARD SHORTCUTS
Using keyboard shortcuts is a great way to save time while working in Acrobat. People with motor

impediments can use keyboard shortcuts to navigate through PDF documents with more ease.

Keyboard shortcuts can also help reduce the risk of acquiring repetitive-motion injuries.

The following keyboard shortcuts are available in Acrobat:

Option Windows Shortcut Mac OS Shortcut

Activate Selected Item Spacebar or Enter Return or Enter

All Content (deselect) Ctrl+Shift+A „-Shift-A

All Content (select) Ctrl+A „-A

Article tool A A

Attach File as Comment J J

Attach Tools (toggle) Shift+J Shift-J

Bookmark (collapse) Left arrow or minus sign Left arrow or minus sign

Bookmark (expand) Right arrow or Shift+plus sign Right arrow or Shift+plus sign

Browser-based review (save Y Y
document and work offline)

Browser-based review O O
(send/receive comments)

Button tool F F

Cloud tool Q Q

Close Current Document Ctrl+F4 „-F4

Close Windows (all) Ctrl+Shift+W „-Shift-W

Context menu (close) F10 (N/A)

Context menu (open) Shift+F10 Control-click

Crop tool C C

Distance tool B B

Document (next) Alt+Shift+Right arrow Option-Shift-Right arrow

Document (previous) Alt+Shift+Left arrow Option-Shift-Left arrow

Drawing Markup tools (toggle) Shift+D Shift-D

Expand All Bookmarks Shift+* Shift-*

Fit Page Ctrl+0 „-0

Forms tools (toggle) Shift+F Shift-F

Go Back Online I I

Hand tool H H

Hand tool (temporary) Spacebar Spacebar

Help window (close) Ctrl+W or Alt+F4 „-W

Help window (open) F1 „-?

Highlighting tool (current) U U
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Highlighting tool (toggle) Shift+U Shift-U

How-To home page Home Home

How To window (next page) Right arrow Right arrow

How To window (open/close) Shift+F4 Shift-F4

How To window (previous page) Left arrow Left Arrow

Link tool L L

Measuring tools (toggle) Shift+B Shift-B

Menu bar (show/hide) F9 Shift-„-M

Move Focus Among Areas F6 (N/A)
of Document

Move Focus Among Tabs Right arrow or Left arrow Right arrow or Left arrow

Move Focus Between Active Tab Tab
Tab and Tab Contents

Move Focus Between Header Ctrl+Tab or Ctrl+Shift+Tab „-Tab or „-Shift-Tab
and Elements of How-To Window

Move Focus Through Elements Tab or Shift+Tab Tab or Shift-Tab
in How-To Window

Move Focus to Comment Tab Tab

Move Focus to Document Pane F5 F5

Move Focus to How-To Window Shift+F1 Shift-F1

Move Focus to Menus F10 F10

Move Focus to Next Comment Tab Tab

Move Focus to Next Element Tab Tab
of Active Navigation Tab

Move Focus to Next Item Down arrow Down arrow
in Navigation Tab

Move Focus to Next Pane or Panel F6 F6

Move Focus to Next Tab Ctrl+Tab „-Tab
(in a tabbed dialog)

Move Focus to Previous Comment Shift+Tab Shift-Tab

Move Focus to Previous Item Up arrow Up arrow
in Navigation Tab

Move Focus to Previous Pane Shift+F6 Shift-F6
or Panel

Move Focus to Status Bar Shift+F5 Shift-F5

Move Focus to Text in Comment F2 (N/A)

Move Focus to Toolbar in Browser Shift+F8 Shift-F8

Move to Next Element in Active Up arrow or Down arrow Up arrow or Down arrow
Tab
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Move to Next Navigation Tab Up arrow or Down arrow Up arrow or Down arrow 
or Ctrl+Tab or „-Tab

Move to Next Open Document Ctrl+F6 „-~ (tilde)
(when focus is on Document pane)

Move to Next Search Result F3 (N/A)

Move to Previous Open Document Ctrl+Shift+F6 „-Shift-F6
(when focus is on Document pane)

Movie tool M M

Navigation pane (open/close) F4 F4

Navigation pane (open and Ctrl+Shift+F5 „-Shift-F5
move focus to)

Note tool S S

Open Pop-up Window for Spacebar Spacebar
Comment That Has Focus

Page (first) Shift+Ctrl+Page Up or Shift Home or Shift-„-Page Up or 
+Ctrl+up arrow „-Shift-up arrow

Page (last) Shift+Ctrl+Page Down or Home or Shift-„-Page Down 
Shift+Ctrl+down arrow or „-Shift-down arrow

Move to Next Search Result F3 (N/A)

Page (next) Right arrow or Ctrl+Page Down Right arrow or „-Page Down

Page (previous) Left arrow or Ctrl+Page Up Left arrow or „-Page Up

Pencil Eraser tool Shift+N Shift-N

Pencil tool N N

Properties dialog box (open/close Ctrl+I „-I 
when an object is selected)

Properties toolbar (open/close) Ctrl+E „-E

Rectangle tool D D

Screen (next) Page Down Page Down

Screen (previous) Page Up Page Up

Scroll (when Hand tool is selected) Spacebar (N/A)

Scroll down Down arrow Down arrow

Scroll up Up arrow Up arrow

Select Next Word or Deselect Ctrl+Right arrow or Left arrow „-Right arrow or Left arrow
Previous Word (when Select tool 
is selected)

Select Object tool R R

Select Text (when Select tool Shift+Arrow keys Shift-Arrow keys
is selected)

Selection tool (current) V V

Selection tool (toggle) Shift+V Shift-V
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Snapshot tool G G

Sound tool Shift+M Shift-M

Stamp tool K K

Text Box tool X X

Text Edits tool E E

Touch Up Object tool Shift+T Shift-T

Touch Up Text tool T T

View (next) Alt+Right arrow Option-Right arrow

View (previous) Alt+Left arrow Option-Left arrow

Zoom tool (current) Z Z

Zoom tool (temporary) Ctrl+Spacebar „-Spacebar

Zoom tool (toggle) Shift+Z Shift-Z

Zoom tool dynamic (temporary) Shift Shift

Zoom In Ctrl+equal sign „-equal sign

Zoom In (temporary) Ctrl+Alt+Spacebar or „-Option-Spacebar or 
Ctrl+Spacebar+click „-Spacebar-Click

Zoom Out Ctrl+hyphen „-hyphen

Zoom Out (temporary) Ctrl+Alt+Spacebar or „-Option-Spacebar or 
Ctrl+Shift+Spacebar+click „-Shift-Spacebar-click

Zoom to Ctrl+M „-M

USING HELP
As with previous versions of Adobe Acrobat, pressing the F1 key (in Windows) or the „-? keys (on

the Mac) activates Acrobat’s online Help. This Help file is independent of the Help file that is com-

mon to Photoshop, Illustrator, GoLive, and InDesign, and it contains very specific information that is

not available elsewhere. 

The Help File
The Help file contains two panes: a Navigation pane on the left side and a Topic pane on the right

side. Entries selected in the Navigation pane are explained in detail in the Topic pane. The

Navigation pane has three tabs you can use to look up information:

• Contents: The Contents tab displays entries in an organized way and resembles a book’s table

of contents. Information is grouped in several expandable main headers.

• Search: The Search tab contains a text field where you can type a word or phrase to look up.

Matching entries are listed underneath it.

• Index: The Index tab contains a very detailed list of most command words and terms used in

Acrobat and included in the Help file. These words are sorted in alphabetical order.
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The How To Pane
In addition to the Help file, Acrobat also has a built-in How To option that contains step-by-step

instructions on how to accomplish many tasks in Acrobat. In addition to these instructions, the How

To pane also displays links to relevant information in the Help file (see Figure 43.50).

43

Figure 43.50
The How To pane contains instruc-
tions to accomplish advanced and
new tasks. These instructions are
grouped under eight generic
headings. The complete Help file
can also be accessed from the
How To pane. 

Help for People with Visual or Motor Impairments
Acrobat makes it easier for people who have impediments to interact with its interface via the

Accessibility Setup Assistant.

Found under the Advanced, Accessibility Setup Assistant menu, this wizard guides you through the

steps to set up screen readers and magnifiers. If Acrobat detects during installation that accessibility

features are present in your computer, the Accessibility Setup Assistant appears the first time you

run Acrobat.

In addition to these settings, you can also use the accessibility options found under the Edit,

Preferences menu to change colors and fine-tune other settings.

If you use a third-party voice reader or Braille reader, you can adjust its settings from within Acrobat

by using the Advanced, Accessibility, Change Reading Options command.
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In addition to commenting, embedding voice annotations, editing text, and rearranging pages,

Acrobat puts a few more advanced features in your hands to enhance your ability to produce files for

press production. Again, if your files require any heavy editing it’s better that it be done in the appli-

cation that created them rather than in Acrobat. These tools in Acrobat enhance your file for opti-

mum reproduction.

UNDERSTANDING OPTICAL CHARACTER
RECOGNITION (OCR)

Optical Character Recognition (OCR) is the ability to “read” text from a rasterized image and create

an editable text from it. There are two ways to use the OCR engine that is built inside Acrobat and

each depends on whether the image that contains the text has already been scanned.

If the image is already part of a PDF document, open the OCR engine by choosing Document,

Recognize Text Using OCR, Start. In the Recognize Text dialog you can adjust language, resolution to

downsample images, and the output method in addition to specifying pages of the document you

want processed. Acrobat recognizes not only the text but also the font and other formatting and pre-

sents the converted text so that it looks as close to the original as possible (see Figure 44.1). If you

need to process only one scanned image in a document you can click on it with the Select tool to

select it. Next, right-click (in Windows) or Control-click (on the Mac) on it and select Recognize Text

using OCR from the context menu.

If you have a printed page—or several pages—with text that you need to convert to editable text you

need to bring it into Acrobat first. To do this, choose File, Create PDF, From Scanner. A dialog

prompts you to select your scanner and edit OCR settings. These OCR settings are the same as when

using the previous method. You can use this feature to scan long paper documents, for example,

if your scanner has an auto-feeder. Acrobat generates the total number of pages of the original

document.
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Figure 44.1
Acrobat makes it easy to use OCR
to generate editable text.
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UNDERSTANDING FONTS
One of the greatest advantages of using PDF files for proofing, as opposed to JPEGs, is that text

remains as editable text and it never loses its crispness. This is of special importance when you are

working across different platforms (Mac/Windows/Linux) and need to make sure that text in a file

looks right every time.

As explained in Chapter 42, “Working in a PDF in Acrobat,” Acrobat makes a copy of the font file,

embeds it within the PDF itself, and uses its own rendering engine to display text with it. This

ensures that text will always render and print as text, with crisp edges and no pixelation.

Recall that Acrobat allows only minor text editing. There’s a reason for that. Acrobat is not a page

layout program or a word processor. Acrobat is a program that you should use to optimize files cre-

ated in other programs. Yes, there are exceptions like creating PDF files from a scanner or using the

Designer (more about that in Chapter 46, “Using Adobe Designer (Windows CS2 Suite Only)”), but

the main objective remains the same.

UNDERSTANDING COLOR
Color is an important part of a production process; Acrobat understands that and has support for the

same color management as the rest of the Creative Suite programs.

Using Color Profiles
When you create images in Illustrator or Photoshop you are given the option to apply an existing ICC

color profile or to create your own. An ICC color profile is a set of values that measures the color

space where the image was created (how your scanner or digital camera “sees” color, for example)

and the color space where it will be reproduced (an offset press or a computer monitor), and then it

translates between both so that the image is reproduced accurately. ICC color profiling is an indus-

try-standard color management method that was created by the International Color Consortium.

When an ICC profile is applied to a file, the information is embedded and travels with it. This

ensures that color is seen as close as possible to its intended output. 

PDF files can also contain ICC profiles and it’s recommended that you use them, especially if your

intended output requires accurate color reproduction. The Color Management panel in Acrobat’s

Preferences dialog comes with many preset profiles you can use (see Figure 44.2). In these profiles

RGB (red, green, blue) refers to the way color shows in a monitor, CMYK (cyan, magenta, yellow,

black) refers to the intended press output, and grayscale refers to the halftone balance of the image.

44

A Word About Dot Gain

Dot gain is the amount by which a halftone dot is expected to expand when applied to paper or other
media during an offset printing process. A dot gain setting of 20%, for example, means that a dot is
expected to expand by that much when it’s printed. The ICC profile uses that information to display a
color, with its intensity increased accordingly.
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Comparing RGB, CMYK, and Grayscale
Acrobat does not give you an easy option to see what elements of a file are done in what color

model: RGB, CMYK, grayscale, or spot color (although there is a workaround that we’ll look at); but it

gives you the option to optimize and/or change color models to fit your intended output using the

Convert Colors feature that we’ll review later in this chapter.

Let’s say for now that knowing the difference between RGB and CMYK is very important if you’re

preparing files for production. RGB  is the color space used to display images in a monitor. Like a TV

set, color in a computer monitor is made up of combinations of these three basic colors. Images saved

in RGB color mode are good for monitor display or for printing on an inkjet printer only. The CMYK

color mode (stands for Cyan/Magenta/Yellow/Black) is a color space used to reproduce color in a

printing press. Presses use inks in those four colors to print tiny dots of varying diameters to repro-

duce other colors. Images saved in CMYK mode are best suitable for print production. Grayscale

images have no color information in them and are suitable for black-and-white display on a computer

or for output on a printing press.

Because image files need to save the information for each of the color components, RGB files are gen-

erally smaller than CMYK files. An RGB image has only three channels, but the same image saved in

the CMYK color mode has four channels. Grayscale images have only one channel. This is important

when you’re optimizing your PDF files. If the intent of the file is print, it’s better to have all the RGB

images converted to CMYK (although it’s even better to do that in Photoshop before creating the PDF).

If the intent is display on a monitor only, having images in CMYK mode only makes the final file big-

ger than it needs to be. The same rings true for grayscale images. A common mistake people make is

to save grayscale images in RGB mode, making the image file three times bigger than it should be.

Although Acrobat doesn’t have a tool to change the color mode of each image, it provides you with a

way to change color mode using the Object TouchUp tool. To use this method, first make sure that

Photoshop is selected as your image editor and Illustrator is selected as your page/object editor in

44

Figure 44.2
Acrobat includes many preset pro-
files to suit different output
needs.
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the TouchUp panel of the Preferences dialog (choose Edit, Preferences to open the dialog, as shown

in Figure 44.3). Next choose Tools, Advanced Editing and select the TouchUp Object tool. Now you

can navigate to where your image is located in the document, right-click (in Windows) or Control-

click (on the Mac) on it, and select Edit Image from the context menu (see Figure 44.4). This com-

mand prompts Photoshop to launch (or Illustrator if the image is a vector) with the image opened

and ready to be edited. After changing the color mode in Photoshop or Illustrator, simply close

Photoshop (or Illustrator) and the image is updated in the PDF document automatically. You can use

this method to do any other editing required, like resizing the image, adding or removing elements,

changing colors, etc.
44

Figure 44.3
For the TouchUp tool to work well
make sure that Photoshop and
Illustrator are selected as your
preferred editors.

Figure 44.4
Select Edit Image to launch
Photoshop or Illustrator and edit
your embedded graphics.
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Acrobat also supports 1-bit images, also known as monochrome images. These are a special type of

image that contain no halftone information and are made out of pixels that can have only a specific

color in them or not, with no variations possible.

What About Spot Colors?
Spot colors are an entirely different color space used for print-

ing. The premise of spot colors is that there are times when a

specific color is required. Spot colors are sometimes referred

to as Pantone colors, the industry standard for selection and

use of spot color in much of the world. Pantone created a way

to organize these varied colors into the Pantone Matching

System (PMS).

When you use a spot color in an image Acrobat produces a

separate plate for that color and the printer has to apply a

pass of that ink in addition to the other four (cyan, magenta,

yellow, and black). Sometimes a job can be done using only

spot colors, in which case only plates in those colors are pro-

duced. 

COMPRESSING PDF FILES
To reduce file size, Acrobat gives you the option to compress

contained images using either ZIP or JPEG compression algorithms. Without getting too technical,

the difference between these two is that ZIP compression maintains an image’s quality integrity.

This type of compression is sometimes referred as lossless. JPEG compression degrades the image

quality and is referred to as lossy. JPEG compression achieves smaller files than ZIP but not without

sacrificing quality. Acrobat also enables you to choose None, leaving your embedded images uncom-

pressed. This option makes your PDF files larger.

As a general rule you should try to avoid JPEG compression,

especially if you are working on documents intended for print.

If your document is to be displayed on screen only you may

get away with a limited amount of JPEG compression without

any visible loss of quality.

Now, here’s the tricky part: If you plan to use JPEG compres-

sion, do not compress your images until you have the final

version of your document ready. This means that when you

create your PDF you shouldn’t apply any type of compression.

To do this, open the Compression panel in the Save Adobe

PDF dialog when you save your file from its originating appli-

cation to PDF. While in the Compression panel, select Do Not

Downsample for all types of images and also disable the

Compress Text and Line Art check box (see Figure 44.5). This produces a larger PDF file, but you will

have the chance to compress it later when you finish editing it in Acrobat.

44

In Illustrator, you can specify any
two colors for monochrome (1-bit)
images. The Fill color becomes
the color of the image itself, and
the Stroke color becomes the
background color. Note that the
color info is not saved in the file.

The PMS Solid (coated) and PMS
Solid (matte) palettes include
some neon and metallic inks.
There is also a specific PMS
palette for metallic color and PMS
Coated and Uncoated palettes for
Pastel colors.

The reason you should not com-
press your PDF images using JPEG
compression is that the JPEG algo-
rithm compresses images even if
they’ve already been compressed.
Because JPEG is a lossy algorithm,
this means that every time you
save your file the embedded
images are being recompressed
and more data is being lost.
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After you have the final version of your document you can use the PDF Optimizer (described in

Chapter 42) to apply compression to your images.

PREPARING FILES FOR PRESS
If your intended output is a printing press, Acrobat offers a wide array of tools to make sure your

final files print the way they should. These tools are grouped in the Print Production toolbar. Let’s

take a look at what each of these can do for you.

Trap Presets
Because of the way inks are applied when printing color in an offset preset and because of the elas-

ticity of the paper stock used for print, sometimes a thin gap may appear between two areas of dif-

ferent colors. To avoid that from happening traps are applied. Traps are very thin lines of

overlapping inks applied to those critical areas to prevent these gaps from appearing. To create a

trap, normally the area of the lightest color is slightly expanded to fit under the area of darker color.

Acrobat files can contain specific information that enables printers to generate traps automatically

when sending a job to press. The default Trap Presets contain generic values for the automatic cre-

ation of traps for most cases, but sometimes a job requires these values to be changed. Acrobat

gives you the flexibility not only to change these default values but also to save them as a recorded

preset. If you have doubts about setting traps, consult with your printer or service bureau. Most

printers prefer to do the trapping themselves, so most of the time you should not worry about trap-

ping. However, if you are producing your own color separation films, these trap settings are avail-

able to you. Settings may vary depending on the particular characteristics of the paper and inks to

be used (see Figure 44.6). The available settings are

44

Figure 44.5
If you plan to edit your PDF in
Acrobat do not apply any com-
pression to it when creating it.
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• Trap Width: This value determines the width the created trap lines should have in points

(points are a measuring unit used in the graphics industry. One point is roughly equivalent to

1/72 of an inch). A trap too wide becomes too visible to the naked eye and makes the image look

bad. The value for the Default option applies to all inks except black. The Black option has its

own separate value and we’ll explain why later in the chapter. The value for the Images option

is for all images if you want to use different trapping widths for images and for colored text or

other objects.

• Trap Appearance: This refers to the way traps behave around corners or on their edges. Setting

the Join Style option to Miter makes the traps have angled corners and edges, and setting the

option to Round makes them look rounded. The End Style option determines the way traps are

shaped when more than two of them meet.

• Images: These options determine how traps behave between or within images. The Trap

Placement option refers to how traps are created between vector objects and raster images.

Enable the Trap Objects to Images option to ensure that traps are created when vectors and

rasters meet. If this option is unchecked no trap will be created. The Trap Images to Images

option does the same when two rasters meet. The Trap Images Internally option has Acrobat

generate traps for color areas within a raster image and not only around its edges. The Trap 1-

bit Images option tells Acrobat to create traps for that type of image as well.

• Trap Thresholds: These values refer to the conditions under which the traps are generated. The

Step value is the amount of displacement between colors that must occur before a trap is gener-

ated. The lower this number the more sensitive Acrobat will be to variations. The Black Color

value specifies how much black ink there must be before a black trap is generated. The Black

Density value applies to spot inks and tells Acrobat when to apply the black ink settings to it.

The default setting of 1.6 means that any spot ink with a neutral density of 1.6 or higher should

be given the same trapping treatment as if it were black. Consult your printing service if you

44

Figure 44.6
You can customize your trapping
preferences and save them for
future use.
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need to obtain neutral density values for special inks you plan to use. The Sliding Trap value

defines when Acrobat should generate a dynamic trap that shifts position depending on the

variation of density between two color areas. If you are using pastel inks, for example, you may

need to give them a special treatment to avoid having the trapping area become darker than the

actual color area. The Trap Color Reduction value helps you do this. A 100% value produces a

trap using 100% of the inks that form it, and a 0% value reduces the amount of ink in the trap-

ping to match the ink’s neutral density. If you are not using spot pastel inks, leave this value at

its 100% default.

44What Is Neutral Density?

Conversion of spot colors to the CMYK space is never exact, and most of the time all you get is a close
approximation. This difference becomes even more obvious if you consider special spot inks like var-
nishes, neons, pastels, or metallic hues. An ink’s neutral density is a value that tells you how much
lighter or darker a spot ink is than its CMYK equivalent. This value tells a commercial printer which of
two or three spot inks “looks” the darkest so that he can adjust the trapping order. A metallic ink, for
example, has a higher density than a process black ink so it should be applied after the black ink and
not before. When working with two adjacent metallic inks, a printer can look at their neutral densities to
determine which should be applied first.

Output Preview 
The Output Preview feature enables you to see how the colors will break when producing separa-

tions and is for reference only. The preview doesn’t display traps or halftone screens, and it

shouldn’t be used for proofing but only as way to check on the amount of ink coverage on the

printed page (see Figure 44.7) or to spot any overprints quickly (see Figure 44.8). 

Figure 44.7
Use Output Preview to see how
each color plate will print and to
check the amount of ink coverage.
Too much ink can result in exces-
sive moisture and cause paper to
break when passing through a
press.
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Preflight
If you are reviewing a PDF file created by someone else, you can have Preflight generate a report in

text or PDF format that you can use for reference (see Figures 44.9 and 44.10).

44

Figure 44.8
Output Preview also displays over-
print areas. Because inks are not
entirely solid but have trans-
parency to them, overprinting can
result in big color variations in the
final product.

Figure 44.9
Preflight comes with many profiles
to help you spot and correct prob-
lems before sending the file to
production.

Convert Colors
Sometimes, due to time constraints or because the document has just too many images that need to

be converted from one color mode to another, you may want to do the conversion with one click. The

Convert Colors dialog is there for you. It is a no-nonsense way to straighten colors across a document

quickly, especially if it’s a long one (see Figure 44.11). It gives you options for three types of images:

RGB, CMYK, and grayscale. You select the intended output and Acrobat converts the images. Keep in

mind that this tool does not magically retouch and correct color. If an embedded image is of poor

quality there’s nothing that Acrobat can do about it.
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Because the cost of reproducing a job increases with the number of inks required, you can also use

the Ink Manager to reduce the amount of inks by mapping an ink to another. There are times, for

example, when an artist may have chosen two slightly different spot colors when only one was

needed. By mapping one of them to the other in the Convert Colors dialog (using the Action pop-up

menu), you tell Acrobat to create one separation plate for both rather than two individual plates (see

Figure 44.12). After color has been mapped to another, it can’t be reversed to its original.

44

Figure 44.10
Use Preflight’s reports to correct
problems before files are sent
to a commercial printer for
production.

Figure 44.11
The Convert Colors dialog is a
quick way to change color modes
to images all across a document
or on selected pages.
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Ink Manager
The Ink Manager is a fast way to preview how many inks are going to be required to reproduce a

job. This is of special importance when working with spot colors since the cost of reproducing a job

increases with the number of inks required. If you need to reduce the amount of inks used in a job

but don’t want to map similar inks, you can use the Ink Manager to alias one ink to another (see

Figure 44.12). Aliasing inks produces the same result as mapping but, unlike mapping, it doesn’t

alter the images in the PDF.

The Ink Manager also enables you to change the trapping sequence of inks (the order in which inks

are printed in a press). Because inks are not entirely opaque but have varying degrees of trans-

parency, the order in which they are printed can make a difference to the final look of your printed

document, especially in trapped areas.

44

Figure 44.12
Use the Ink Manager to change
ink density, trapping order of inks,
or to alias one ink to another.

Add Printer Marks
Printer marks are markings placed on film, outside the actual print area, that help printers by identi-

fying what plate should be what color, the positioning of the page, the name of the job, registration

marks, and so forth. Without printer marks a printer would be clueless as to what to do with a piece

of film after it’s produced. Acrobat can generate these printer marks automatically based on parame-

ters you feed it in the Add Printer Marks dialog (see Figure 44.13).

Crop Pages
What happens if the page size in Acrobat is not the final page size intended? A page in Acrobat

could contain bleed areas or be a two-page spread, for example, in which case autogenerated printer

marks would be placed in the wrong places. In situations like that, the Crop Pages dialog enables

you to set up margins to define the exact size the finished product should be.
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The crop box is the area that the final product will be and it is the area that the printer marks will

frame. The trim box represents the actual size of your PDF page. The bleed box is the area that will

be printed outside the trim box when there are bleeding objects or images (a bleed is when a page

is printed all the way out to its edge). The art box (or media box) is the size of the page as it was

exported from the application that created it (see Figure 44.14).

44

Figure 44.13
The Add Printer Marks dialog.

Figure 44.14
The boxes in the Crop Pages
dialog.
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Fix Hairlines
Fix Hairlines is a straightforward feature. If there are any thin lines in the PDF that are part of text

strokes or part of a vector object, Acrobat makes sure that they’re not too thin and bumps up their

width so that they show when the document is printed. Acrobat uses the parameters you supply in

the Fix Hairlines dialog to accomplish this.

Transparency Flattening
If your document contains overlapping raster images with transparency (like embedded GIF or PNG

images), Acrobat flattens them at print time. However, if your document contains overlapping trans-

parency vectors, Acrobat breaks each transparent area into pieces of solid (flat) color that can be

either new vectors or rasters. You can determine how much of these transparent areas are converted

to rasters or vectors using the Transparency Flattening feature and its Raster/Vector Balance slider.

The lowest setting produces all the areas to become rasters, and the highest setting makes them all

vectors. You can also determine the resolution of these generated rasters.

The vector/raster conversion is important if you are concerned about file size. Converting all trans-

parent areas to raster produces larger files, and having Acrobat generate too many small vector

images adds an extra demand on processing to the RIP or printer, which can translate to a longer

processing time.

PDF Optimizer
The PDF Optimizer dialog has several panels with options to clean up your PDF and make it smaller

and easier to transport. Clicking on the Audit Space Usage button generates a report telling you

what elements use how much space and their percentage in relation to the entire file size. After you

have edited these settings you can save them for future use:

• Images: In this panel you can apply compression to all rasters embedded in your file and down-

sample them if their resolution is too high. These settings apply across the document, not to

individual images (see Figure 44.15).

• Scanned Pages: The settings on this panel apply compression and correction filters to images

that have been acquired using the Create PDF From Scanner function. However, turning on this

option disables the settings in the previous panel (see Figure 44.16).

• Fonts: As explained in Chapter 43, you can use this panel to unembed fonts that are no longer

required.

• Transparency: The settings on this panel are the same settings found in the Transparency

Flattening option.

• Discard Objects: Use the settings on this panel to select types of elements to be discarded from

your PDF. You should be careful using these options because discarded objects can’t be brought

back. The Discard Embedded Thumbnails option, for example, removes the page thumbnails you

see in the Pages tab. The Discard Document Structure option removes tags and reflow informa-

tion. If you have layered objects (like drawing done in Illustrator) Discard Hidden Layer Content

merges all layers.

44
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• Clean Up: This panel contains complementary settings to the previous one. You can choose to

apply Flate (ZIP) compression to text or other parts of the file or remove bookmarks to pages

that no longer exist. The Remove Unreferenced Named Destinations option looks for destina-

tions that have no link within the same document, so if you have links in other documents you

should not check this option (see Figure 44.17).

44

Figure 44.15
If your images are already embed-
ded at the right resolution, you
can turn Downsampling off.

Figure 44.16
The compression settings in the
Scanned Page Settings slider
override those in the Images
panel.
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JDF Job Definitions
Job definition files (JDFs) are small files that can be attached to a PDF and contain information,

such as number of copies to be made; the type of stock to be used for cover, body, and any other

special sections in your document; the person to contact; billing information; a preflight report; and

more. The job definitions are saved in a file of JDF format that you can reuse in future jobs (see

Figure 44.18). 

44

Figure 44.17
Some of the PDF Optimizer set-
tings are undoable and therefore
you must practice caution using
them.

Figure 44.18
Job definitions contain all the
information required for a printer
to reproduce your document in a
press environment.
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Show/Hide Print Production Toolbar
Choose Tools, Print Production to toggle between showing and hiding the Print Production toolbar.

EMBEDDING AND DISPLAYING 3D OBJECTS
Another advanced feature in Acrobat, although it has nothing to do with print production, is its new

ability to embed and display 3D images created in AutoCAD. It’s always been difficult for CAD mod-

elers to send “live” 3D models to clients for proofing. With this new ability Acrobat makes it easy for

them to send samples of work to clients in a PDF that can also be annotated or to use live 3D models

in their portfolios.

To insert a 3D object first make sure the object is in U3D format. While in Acrobat, use the 3D tool to

drag a placement box for your file. Use the dialog to navigate and select your 3D file—and bingo.

That’s all there is to it. When a user clicks on it, a control panel appears with options to pan, walk

around, zoom, and move the 3D object (see Figure 44.19). 

44

COLLECTING DATA FROM FORMS
Although Acrobat gives you some basic tools to convert a document into an electronic form—a

legacy from the pre-Designer days—it is better to use Designer if you intend to create new forms

from scratch and are feeling creative about the way your forms should look. The drawback is that

Designer is available only to Windows users. For Mac users the legacy form tools in Acrobat should

still be able to do a decent job. You have already learned about those tools in Chapter 43,

“Understanding Menus and Options in Acrobat,” and you explore Designer in Chapter 46, so let’s

concentrate for now on how you can use Acrobat forms to collect data. Electronic forms can be used

to survey your clients about the quality of your services, for example, or to submit tests in web-

based training courses.

Figure 44.19
Your peers can use the 3D control
panel to move embedded 3D
objects.
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There are two basic ways to set up a form to collect data via Acrobat: email-based and web-based.

In an email-based collection you create a list of email recipients to whom you’ll send the form, and in

a web-based collection you upload the form to a web server to be accessed via a web browser. To

create either one, you need to insert a Submit button in your form using either Acrobat or Designer. 

Creating a Submit Button
To create a Submit button in Acrobat use the Button tool in the Advanced Editing menu or the Forms

toolbar and create a normal button. Right-click (in Windows) or Control-click (on the Mac) on it to

access its properties. Click on the Actions tab and pick Mouse Up from the Select Trigger pop-up

menu. Under the Select Action pop-up menu, pick Submit a Form and hit the Add button. In the next

dialog you have two main options. If you want the data to be sent to a web server, enter the server’s

URL in the Enter a URL for This Link field. If you want the data to be sent to your email address,

enter the text mailto: followed by your email address, with no spaces between.

Next you need to select a format for the form to be exported. FDF is good if your peers will be using

the Adobe Reader to fill the form; PDF is good if the form contains a digital signature that you want

to preserve. XFDF can also be filled using the Adobe Reader and gives you the option not to include

comments. HTML converts the document to HTML format. You also have the option not to include

some fields by clicking on Select Fields and checking only those you want to make fillable to your

peers (see Figure 44.20).

Click on the other tabs to edit the way your button should look, and you’re done with that part. Now

you need to set up your data collection flow.

44

Figure 44.20
From the Field Selection dialog
you can uncheck any fields that
you want to make unfillable.
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The Data Collection Workflow
If you want to have a web server collect the form data, you need to install and configure CGI soft-

ware on the server. Acrobat does not include that software and you should consult with your web

host provider regarding CGI scripts.

If you want to collect the data via email, you can use Acrobat’s automated option to send your form

to its intended recipients. To do this choose Advanced, Forms and click on Initiate Data File

Collection Workflow to launch the Initiate Form Data Collection Workflow wizard; you are prompted

to enter the email addresses of all the peers you want to receive the form. After you entered the

addresses, clicking Next takes you to the message that will be emailed to your peers. Acrobat uses a

default invitation, but you can customize it at will. The default invitation contains detailed instruc-

tions for those not familiar with Acrobat or with electronic forms (see Figure 44.21). When you click

on Send Invitation, Acrobat opens your email client and prompts it to send an email containing the

invitation and the form as an attachment to all the recipients you specified.

44

Collecting the Data
When your peers click on the Submit button that you created in the form, the data is sent to the

email address you specified in its Enter a URL for This Link field. The data comes in the format you

specified. It’s helpful to create a new folder to save the data files to, which makes it easier for

Acrobat to find the data and process it.

After opening the received emails and saving the attached files to your new folder, you can use

Acrobat to process them and generate a CSV file. A CSV file is a comma-delimited spreadsheet file

that you can use in Excel or any other spreadsheet program to analyze data. Note that Acrobat can’t

generate a CSV file if the data has been sent to you in HTML format. If you want to take advantage

of this processing option you must have the data sent to you in either XML, FDF, PDF, or XFDF. You

can choose the format in which the data will be sent to you in the Submit button properties.

To generate a CSV file from your collected data choose Advanced, Forms, Create Spreadsheet From

Data Files. In the dialog that appears you are prompted to select the data files you’ve received. Click

on the Add button to navigate to the folder where you saved these files and they will be added to

the Files To Export Data From list (see Figure 44.22). If you want to remove files from the list simply

Figure 44.21
The default invitation contains
detailed step-by-step instructions
on how to fill and submit the form
back to you.
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select them and click on Remove. After your files are selected, click on Export. Acrobat prompts you

to select a location to place the new CSV file.

44

Figure 44.22
Use the Ctrl (Windows) or „ (Mac)
key as you click to select several
files at once.

THE JAVASCRIPT EDITOR
Actions in Acrobat are handled using Adobe’s own version of JavaScript. You can attach scripts to

buttons or other form objects using the Run a JavaScript option in the Actions tab when editing

these objects’ Preferences. Keep in mind that the Adobe Reader doesn’t support custom JavaScript,

so if you intend your form to be filled using the Adobe Reader, you should avoid using custom

scripts.

Figure 44.23
You can add JavaScripts to your
document easily using Document
Actions.
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Another way to use JavaScript is by choosing Advanced, JavaScript, Document Actions. Document

Actions are basic states that Acrobat watches to trigger JavaScripts. You can use a JavaScript pop-

up, for example, to thank your customers for filling out a survey form when they close it (see

Figure 44.23). 

To learn more about Adobe JavaScript you can visit the JavaScript reference page in the Adobe web-

site at http://partners.adobe.com/public/developer/pdf/topic_js.html.

THE ORGANIZER
You will simply love the Organizer. Imagine a window from where you can view thumbnails of all

the pages in your PDF documents before you open them. Neat, huh? The Organizer gives you that

and more.

To open the Organizer choose File, Organizer and select Open Organizer. Its left panel gives you a

list of your recent history, a view of your hard drive, and a list of your created Collections. The cen-

tral panel shows you a list of files in either a selected folder or Collection. The right panel shows you

a preview of any file you select in the center panel.

Besides helping you organize your files in Collections, the Organizer has a few other nice functions

on its own toolbar. You can use it to print files without having to open them, email files using your

mail client, send files for review when they’re enabled for that, or merge several files into one PDF

(see Figure 44.24).

44

Figure 44.24
Easily merge several files into one
using the Organizer.

As you can see, there’s a lot more in Acrobat than embedding fonts; and in the previous two chap-

ters you only scraped the surface of these neat features. As with the other elements in the Creative

Suite, delving deeper into its features would require an entire book. However, the review presented

here should help you understand Acrobat better and garner some of its power.
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Acrobat Distiller is a compact program that interprets PostScript (PS or EPS) files and converts them

to the PDF format. When you use Distiller to create a PDF file from a PostScript file, the new PDF file

preserves all the data in the original PostScript and adds functions that are not supported by the

PostScript format directly, like comments, font embedding, image compression, and more. In some

cases you may be working with designers that don’t have access to Acrobat and the programs they

use have no PDF-creation capabilities. In any case, you can use Distiller to convert PostScript files

one at a time or use its automation features to process entire folders.

SETTING DISTILLER PREFERENCES
Distiller’s Preferences dialog is very simple. The Startup section refers to actions that happen when

Distiller is launched. If the Ask for PDF File Destination check box is disabled, Distiller places the

new PDF in the same folder location where the originating PostScript file is. You can also have

Acrobat launch and display a new PDF after it’s been created by Distiller (see Figure 45.1).

45 Figure 45.1
Distiller Preferences dialog.

CREATING AND LOADING .JOBOPTIONS
If the Distiller settings dialog looks familiar to you, it is because it’s the same panel you see when

customizing settings in the Adobe PDF printer driver. Distiller uses the Adobe PDF engine to gener-

ate PDF files and, as you saw in the previous chapter, you can choose from many presets that fit

most common output targets. At any time, you can select an existing setting, make whatever

changes necessary to it, and save it as a custom setting. 

Custom settings can be saved for future use and loaded using the Distiller Default Settings pop-up

menu at the top of the screen. These settings are saved as .joboptions files in a default location:

\Documents and Settings\All Users\Shared Documents\Adobe PDF 7.0\Settings (for

Windows) or Library/Application Support/Adobe/PDF/Settings (for Mac). Settings saved
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Working with Watched Folders

after you choose Print, Adobe PDF can be used in Distiller and vice versa. You can also send these

settings to your peers or load settings sent to you.

To load a .joboptions file into Distiller, choose Settings, Add Adobe PDF Settings and navigate to

the location of the .joboptions file. The file is copied to Distiller’s default settings folder and

appears listed in the Defaults pop-up menu. Similarly, you can use the Remove Adobe PDF Settings

option to delete from the default folder .joboptions files that you no longer need (see Figure 45.2).

Some printing shops and service bureaus allow clients to download free .joboptions files that

they can use to make sure their PDF files are created up to standard and to minimize errors during

processing. 

WORKING WITH WATCHED FOLDERS
One of the greatest features in Distiller is its ability to process many files automatically and without

supervision. In fast-paced environments like newspaper or magazine production, this ability is of

vital importance. Distiller does this through the use of watched folders. A watched folder is a folder

in your computer that Distiller “keeps an eye” on.

Creating and Editing Settings in Watched Folders
To set up a watched folder, choose Settings, Watched Folder to launch the Watched Folder dialog

(see Figure 45.3). Clicking on the Add button enables you to navigate and select a folder to include

in the watched folders list. When a folder is added, Acrobat creates two new folders inside your

selection: In and Out. Distiller monitors the contents of the In folder and, when a PostScript file is

dropped in, it automatically processes it and places the new PDF file in the Out folder.

Figure 45.2
It’s always a good idea to make a
backup copy of your custom
.joboptions files before deleting
them.
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Distiller enables you to select individual Settings files for each folder in the list by selecting it and

clicking on the Load Settings button. You can also adjust settings if they are not saved by clicking on

the Edit Settings button to open the Adobe PDF Settings dialog.

Changing Security Settings in Watched Folders
You can add security features to the new PDF files by selecting a watched folder and clicking on the

Edit Security button. These settings are the same as found when you create password-based security

policies in Acrobat (see Figure 45.4). You can set different security levels for each folder in the

watched folders list. When a watched folder has security settings added to it a lock icon shows next

to its name in the list.

45

Figure 45.3
Distiller allows up to 100 different
folders to be added to the
watched folders list.

Figure 45.4
Setting separate security policies
to each watched folder is possible
in Distiller.
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Changing Other Settings
You can also use the Watched Folders dialog (choose Settings, Watched Folders) to set a time inter-

val for Distiller to check for new files. The maximum interval is 9999 seconds, which is equivalent to

roughly 2 hours and 45 minutes. Deleting old files automatically to save hard drive space is also

possible.

Processing Files
When a file is dropped in the In folder of a watched folder, Distiller automatically processes it using

the settings selected for that folder, and it saves the PDF in the corresponding Out folder. You can

use this functionality to process PostScript or EPS files sent to you via email or via a web server, for

example. Or if you want to add security to your documents automatically without having to open

them in Acrobat, save them as PostScript files in the In folder of the corresponding watched folder

and Distiller takes care of the rest.

You can also process individual files by using the File, Open menu and navigating to the location of

the file or by dragging and dropping the file icon into the Distiller window. Distiller uses the settings

selected in the Default Settings menu to process files selected individually (see Figure 45.5).

45

WORKING WITH FONTS
Sometimes you need to embed fonts in the PDF files created by Distiller. This is specially important

if the PDF files are being sent out for production; a missing font can wreak havoc in a fast-produc-

tion environment.

Distiller automatically looks for fonts to embed in the Program Files\Adobe\Adobe Acrobat

7.0\Resource\Font folder and the Windows\Fonts folder in Windows and in the /Resource/Font

Figure 45.5
You can drag and drop several
files at once into Distiller’s win-
dow for processing.
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folder, Users/(username)/Library/Fonts folder, /Library/Fonts folder, and

/System/Library/Fonts folder in a Mac OS environment.

Additionally, you can add more folders to Distiller’s list by choosing Settings, Font Locations and

clicking on the Add button. You can also select a folder from the list and click on Remove to stop

Distiller from looking for fonts in it (see Figure 45.6).

45

Figure 45.6
Distiller’s Font Locations list.

DISTILLING ERRORS
Sometimes, if a PostScript file hasn’t been exported properly or there is any other kind of problem

that prevents Distiller from generating a PDF, the file is skipped and a text log file is created in the

same location where the PostScript is located. The most common errors are due to memory problems,

font issues, or corrupted PostScript files. 

Font-related error messages usually have this form:

%%[ Error: invalidfont; OffendingCommand: findfont ]%%

An invalidfont type error usually occurs when a font used in the PostScript file is not present in

any of the Font Locations folders or if the font is present but can’t be embedded due to restrictions

set in the font by its manufacturer. A less common error is when a font file has become corrupted.

Memory problems (not enough memory available) or corrupted PostScript file problems usually pro-

duce errors with this form:

%%[ Error: undefined; OffendingCommand: xxxx ]%%

where xxxx corresponds to a string of code that Distiller can’t recognize.

Sometimes, if the error is caused by low memory available, shutting down other applications and re-

sending the PostScript file to Distiller solves the problem. If the problem is a corrupted PostScript file,

the only solution is to have it re-created.

Other errors can have more cryptic headers like exch or limitcheck. The first often refers to cor-

rupted graphics embedded in the PostScript file, and the second to excessively complex vector

objects. In both cases the only solution is to go back to the application that created the PostScript file

and fix the problem there.
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WHAT IS PDF/X?
The PDF/X file format was created with the objective of eliminating problems when making PDF

files for press production. It is not a substitute for PDF but rather a “flavor” of it customized for

press.

The reason to create the PDF/X format was that not all PDF

files are suitable for press, which is one of the strengths of

PDF format, after all. Distiller solved that problem partially by

enabling users to save and share .joboptions files, but in

order for them to work, a user needs to have Acrobat.

Because these days there are several third-party programs

that do the same task as Distiller—create PDF files from

PostScript files—using .joboptions files with them is

impossible. This prompted many printing industry leader

companies to work on a standard format that could be used

with press production in mind, and that’s how PDF/X was

created.

Currently there are two main versions of PDF/X, each suitable

for a distinct market. Which to use? It mainly comes down to

where you are. If you are in North America the PDF/X-1a for-

mat is right for you because it uses the U.S. Web Coated

(SWOP) working profile. If you are in Europe, the PDF/X-3 is

for you because it uses the Euroscale Coated profile instead.

In addition to those two, the PDF/XA standard is currently being developed as a format for optimum

archival of documents.

PROCESSING A FILE WITH DISTILLER
When you open a file with Distiller, it starts to process it right away. This means that if you need to

adjust any settings you should do it before opening a file.

To process files individually, choose File, Open in Distiller and then select the file to process (you can

select more than one by holding the Ctrl key and clicking the files you want to process). As soon as

you click OK, Distiller starts to process the selected file. The file’s name shows in Distiller’s main

pane. You see a status bar indicating the job progress. After the processing is completed, a small

report shows in Distiller’s Status pane (the bottom one) indicating whether there are any errors and

the time the processing was completed (see Figure 45.7). If you need to pause a job, click the Pause

button and Distiller stops working. To continue after a pause, click the same button again; Distiller

takes off from where it stopped.

Another way to process files is to drag and drop them from any open folder into Distiller’s window.

The result is the same as when you open them using the File, Open command. If you have Watched

Folders set, dropping the files in it is all you need to do. Distiller sees them in its next round and

processes them automatically.

45

The difference between those two
working profiles is mainly that of
different dot gain values.
Traditionally, in the United States,
printers have used negative film
to produce printing plates, but in
Europe positive film is the stan-
dard. The result of these different
methods is that a halftone done in
the United States has a larger dot
than the same one done in
Europe, resulting in a darker U.S.
print. To ensure accurate repro-
duction, the SWOP and Euroscale
profiles compensate for that
variation.
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If you have many old entries in Distiller’s Status pane, you can right-click the pane and select Clear

All from the context menu to remove the old files. The same context menu enables you to view or

clear Distiller’s default log file. The log file is a text transcript of all the messages you see displayed

in the Status pane; it’s stored in C:\Documents and Settings\(username)\Application

Data\Adobe\Acrobat\Distiller 7\messages.log (in Windows) or Users/(username)/

Library/Application Support/Adobe/Acrobat/Distiller 7/messages.log (on the Mac).

The file can be viewed with any text editor. If you set Distiller’s Preferences to create a log for indi-

vidual jobs, that log is saved as (filename).log in the same folder as the PDF is saved in, and it

contains only the report for that particular file.

As you see, Distiller is not as intimidating as it may look. On the contrary, it’s a very simple program

to use, and it is a great ally if you need to process PostScript files into PDF files on a regular basis.

45

Figure 45.7
Distiller’s progress bar and the
report in the Status pane.

53_0789733676_ch45.qxd  8/17/05  10:39 AM  Page PDF:1024



46
USING ADOBE DESIGNER

(WINDOWS CS2 ONLY)

I N  T H I S  C H A P T E R

Best Practices (When to Use and Not Use Designer) PDF:1026

New Features (What Was Designer Previously?) PDF:1027

File Format Chart (Import, Export, Save) PDF:1028

Creating a Simple Form PDF:1028

Barcodes and Custom Objects PDF:1038

Substituting and Embedding Fonts PDF:1038

JavaScript Inside Forms PDF:1039

54_0789733676_ch46.qxd  8/17/05  10:39 AM  Page PDF:1025



PDF:1026 Chapter  46:  Using Adobe Designer (Windows CS2 Only)

Adobe Designer—also known by its official name of Adobe

LiveCycle Designer—is part of LiveCycle, an Adobe family of

programs aimed at streamlining the production and process-

ing of intelligent documents and forms in an enterprise envi-

ronment. Designer’s part in that initiative is the creation of

electronic PDF and XDP forms and form templates. Designer

uses the same form creation tools found in Acrobat but pro-

vides more customization options. A lot more, actually, which

is the reason why Adobe has included it in the Creative Suite

(see Figure 46.1).

46

LiveCycle is geared toward enter-
prise management of documents
(especially government docu-
ments). Because most enterprise
document handling is Windows
based, Adobe has focused on that
platform. There is no Mac version
of LiveCycle programs.

Figure 46.1
Designer shows its LiveCycle roots
in its welcome screen and in an
interface that is different than that
of Illustrator, Photoshop, or
GoLive.

BEST PRACTICES (WHEN TO USE AND NOT USE
DESIGNER)

Why use Designer if you already have form creation and editing tools in Acrobat?

The answer is that, unlike Acrobat, with Designer you can create forms from scratch. Think of it as a

page layout program for forms. This means that, besides the tools to create form elements, Designer

also enables you to import graphics (like your company’s logo), create blank pages, add text boxes,

and more.

Designer also comes with many predesigned templates for most common form tasks. And you can

create and save your own forms as well.

So, if you need to modify an existing form quickly or add a couple of form elements to a PDF docu-

ment, Acrobat is your answer. If you need to create an entire set of forms for your company, visually

enhance forms beyond Acrobat’s capabilities, or add JavaScript to your electronic forms, Designer is

your answer.
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There are other advantages of using Designer as part of a LiveCycle enterprise solution, but we con-

centrate on what makes Designer a good addition to Adobe Creative Suite. If you want to learn more

about LiveCycle products, visit http://www.adobe.com/products/server/main.html.

NEW FEATURES (WHAT WAS DESIGNER
PREVIOUSLY?)

Designer was born out of two different programs, Form Designer 4 and Output Designer 5, after

Adobe acquired their creator Accelio in 2002. When Adobe decided to create the LiveCycle initiative,

it merged these two programs into one: Adobe LiveCycle Designer 6.

In Designer’s current incarnation, Adobe has included some welcomed additions. First is its integra-

tion with Acrobat 7. Because of its origins outside Adobe, earlier versions of Designer generated

forms in proprietary formats that were still supported until version 6. In the current version Designer

has gone “full PDF,” and forms created with it are compatible with Acrobat 7. If you choose

Acrobat’s Advanced, Forms, Create New Form menu option, Designer is launched. In Designer, click-

ing on the PDF Preview tab (more about it later in this chapter) displays some basic Acrobat tools

and Acrobat’s Navigation Tabs pane (see Figure 46.2).

46

Linking interactive images is also a new feature in Designer. You could have, for example, a webcam

feed updated photos of your office environment to a web server and have the photo linked in a form.

Anyone reading or filling out the form could see the updated photos as long as they’re connected to

the Internet.

Perhaps the most impressive addition to Designer’s arsenal is its capability of generating a paper

form’s barcode. If a user doesn’t have access to the Internet they can fill in the form using the

Acrobat Reader and print it. The form prints with a barcode containing the data entered. The user

can then fax or mail you the form and you can extract the data using a barcode reader with no need

to retype it all.

Figure 46.2
Better integration with Acrobat is
just one of Designer’s improve-
ments.
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FILE FORMAT CHART (IMPORT, EXPORT, SAVE)
Following is a chart of formats currently supported by Adobe Designer 7.0:

Format Open Save As

Adobe PDF (PDF) X X

Adobe XML forms (XDP) X X

Adobe Designer Templates (TDS) X X

Adobe Form Designer 5.0 (XFT) X N/A
(legacy proprietary format)

Adobe Output Designer (IFD) X N/A
(legacy proprietary format)

Microsoft InfoPath (XSN) X N/A

Microsoft Word (DOC, RTF, DOT) X N/A

In addition, Designer can also import the following image formats to be used in forms:

• Bitmap (BMP)

• Joint Photographic Experts Group (JPEG)

• Not animated CompuServe Graphic Interchange Format (GIF)

• Portable Network Graphics (PNG)

• Tagged Image File Format (TIFF)

CREATING A SIMPLE FORM
The easiest way to create a form in Designer is by opening one of many preset templates and cus-

tomizing it. To do this click on the New From Template icon in the welcome screen to display the

New Form Assistant (see Figure 46.3).

After choosing a template from Designer’s comprehensive list you are prompted to select a delivery

method, how you want the form returned to you. Selecting Print makes the form not fillable electroni-

cally; the user prints it and fills it manually for submission by fax or mail. Selecting Fill Then

Submit/Print enables users to fill the form using Adobe Reader and then either print it or submit it to

an email address of your choice. You need to enter an email address at this point but you can edit it

later. Depending on your selection Designer automatically places buttons for Print and/or Submit in

your new form. Clicking on the Finish button accepts these options and you see your form (a copy of

the editable template, actually) displayed in Designer’s work area.

Form Tools and Palettes
The first thing you notice in Designer’s interface is that it’s different from Acrobat and closer to the

Photoshop/Illustrator work area, with a grid all across your new form and dockable palettes on the

right. 

46
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The grid is there to help you position your form objects and you can make it visible or invisible by

choosing View, Grid. Rulers around the top and left sides of your work area are there for the same

reason and can also be turned off by choosing View, Rulers. If you need guidelines, you can drag

them from the rulers.

The most important palettes for now are the Library palette—situated at the top of the right panel—

and the Object palette, situated right under the Library.

The Library palette contains all the objects you can add to your form, separated onto three tabs:

Standard, Barcodes, and Custom. In the Standard tab you see many of the same objects found in

Acrobat’s Forms toolbar plus a few more, such as Text Box, Password Field, Email and HTTP button,

Print button, Submit button, and so on. To insert any of these objects into your form, drag them from

the palette and drop them in the work area. Another way to insert these objects is by picking one of

the tools from the Library and dragging the mouse pointer across your page. Characteristics of these

boxes can be edited using the Object palette. Let’s take a quick look at what each of these objects in

the Standard tab does. You look at the other tabs later in the chapter.

• Text: Insert text blocks in the body of your form. These are not fillable fields, but just simple

text like your company’s address, for example, or instructions on how to fill out the form. You

can change font, font size, style, and alignment using the Font and Paragraph toolbars; or you

can double-click on it to display the Font and Paragraph palettes, which have more options like

font color, indents, line spacing, and vertical alignment (see Figure 46.4). You can also use the

Object palette to change the box size, position in the page, fill color, outline style and color,

and more.

• Text Field: Draw a fillable text field where a user can enter text. This tool has two parts, a label

area and a field area. The same Text, Paragraph, and Object customization options are available

as with the text box—plus, you can highlight the text in the label side and change its format-

ting. Use the Value tab in the Object palette to determine whether filling a text field is required

or not before submitting the form to you.

46

Figure 46.3
Designer comes with templates to
fill almost any corporate need.
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• Numeric Field: This is like a text field but it only accepts numeric values that can be adjusted

from the Object palette (see Figure 46.5).

46

Figure 46.4
Unlike with Acrobat, with Designer
you can add text boxes and type!

Figure 46.5
You can adjust the way numbers
are displayed in a Numeric Field
from the Object palette.

• Password Field: Create a field for users to enter a password when you want to restrict access

to the form to only authorized people. If an incorrect password is entered, the fields can’t be

filled in.

• Check Box: Create check boxes just like the ones in Acrobat but with more design options

through the Object palette (see Figure 46.6).
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• Radio Button: Create radio buttons similar to those you can create in Acrobat but with more

design options (see Figure 46.7).

46

Figure 46.6
You can change the outline and
fill color of your check boxes.

• Drop-down List: Like Acrobat’s combo boxes, Designer’s drop-down lists display a list of items

to select from, like credit cards. Clicking on the + icon in the Field tab of the Object palette

enables you to add items to the list (see Figure 46.8).

Figure 46.7
Gradient fills are available for
radio buttons and check boxes.
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• List Box: Create a list of items for users to select from. This is similar to using Acrobat’s List Box

form object.

• Button: Create general-purpose buttons that can be used to trigger actions. Unlike Acrobat but-

tons, you can’t use an image as a button in Designer.

• Email, HTTP, Print, and Reset Buttons: These buttons are precoded for specific tasks. Email

and HTTP buttons enable users to send the filled form to you via email or by uploading the data

to a server. The Print button sends the form to the user’s default printer. The Reset button clears

all data entered in the form.

• Date/Time Field: A custom field that accepts data in a predefined form that you can cus-

tomize—for example, DD-MM-YYYY.

• Image and Image Field: Display images in both, but they but work in different ways. An image

could be as simple as a corporate logo that you want to add to your form. An image field is a

placeholder that can be used to link an external image in a dynamic type of form, such as

displaying a thumbnail after a user has selected a photo from a list box, for example (see

Figure 46.9).

• Lines, Rectangles, and Circles: Create basic geometric shapes that you can use to enhance your

form visually. 

• Signature Field: When collecting sensitive information, you can set a signature field to enable

users to add an electronic signature to a form after they fill it in. When they add a signature,

filled fields become locked and can’t be edited or cleared.
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Add items to drop-down list here

Drop-down list

Figure 46.8
Drop-down lists can contain any
type of item. 
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• Subform: Create a sort of bounding box used to group elements in a page. When subforms are

used in dynamic forms, they ensure that the data entered doesn’t flow beyond the subform’s

boundaries, helping preserve the form’s visual integrity. When you create a new form or add a

blank page to an existing form, a subform is automatically created defining the margins on the

page, and additional nested subforms can be created (see Figure 46.10). You can use subforms

to keep objects grouped by sections on a page and make them easier to move around.

46

Figure 46.9
Use images or image fields to add
your corporate logo or other
visual enhancements to a form.

Subform Subform

Subform

Figure 46.10
Each page in a form document is,
by default, a subform. In the fig-
ure, elements are grouped in
three subforms shown as thin
blue container boxes.
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• Content Area: A content area is like a super subform that resides in a layout’s master page (you

learn more about them later) and provides a bounding box across the entire document—and not

only for one page as bounding boxes do. Content areas can be edited only through the Master

Pages tab in the work area or Layout Editor.

• Paper Forms Barcode: Add a special container field for an Adobe Paper Forms Barcode. If the

option is enabled, when a user fills in a form via Acrobat or Adobe Reader, the barcode is auto-

matically updated to contain the data entered in an encoded form. The user can print the filled

form, sign it, and mail or fax it to you. You can then scan the barcode with a standard 2D bar-

code reader to collect the encoded data in XML form. To be able to collect the data, you need to

install the Adobe LiveCycle Barcoded Forms 7.0 ST decoder software. To learn more about

Adobe LiveCycle Barcoded Forms 7.0 ST, visit the Adobe website at

http://www.adobe.com/products/server/barcodedpaperforms/. 

All these objects can be customized through the Object palette or by right-clicking on them and

selecting the same options from the context menu.

The Layout Editor Tabs
The Layout Editor is the main area of Designer’s window, where you work with your form. It con-

tains four tabs that give you different previews of your document and can be made active from the

View menu: 

• Body Pages: This is the view you see when you start work on a form. It shows you the form

objects, grid, and subform outlined in blue.

• Master Pages: A master page is an underlying page that contains elements common to more

than one page in your form document. You can use master pages to place your corporate logo, a

watermark, or header and footers to be repeated across an entire document. You can also use a

master page to place repeating fields like a user’s name or a date/time field, or to insert page

numbers (see Figure 46.11). Master pages are listed in the Hierarchy palette.

• XML Source: This tab displays the XML code for the entire document and should not be manu-

ally edited; it is mainly for reference only. To display the XML code for a particular object in your

form, select it in the Body Pages tab or in the Hierarchy palette and click on the XML Source tab.

• PDF Preview: When you click on this tab you see your form as it will look in Acrobat or Adobe

Reader. The preview even enables you to see Acrobat’s left navigation pane without the

Bookmarks tab (see Figure 46.12). If you are working on an existing PDF form, this tab is not

available.

46
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The Hierarchy Palette
The Hierarchy palette is an object inspector of sorts that enables you to see the structure of your

document at a quick glance. You can see the objects in each page listed by groups (subforms), and

you can also manage your master pages or add or delete body pages from there (see Figure 46.13).

46

Figure 46.11
A numeric field with the proper
Value tab settings can be used in
a master page to add auto page
numbering to your document.

Figure 46.12
You can quickly see how your lay-
out will look in Acrobat or Reader
by clicking on the PDF Preview
tab.
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Using the How To Palette
The How To palette contains step-by-step instructions for 10 commons tasks in Designer, ranging

from creating new fields to merging text objects. The tutorials are easy to follow and can help you

get a quick grip on Designer.

Importing a Document from Word
If you have forms created in Word it’s easy to convert them to Designer and/or save them as

Designer templates.

From the Welcome screen or the File menu, select New Form to open the New Form Assistant dialog.

Enable the Import a Word Document radio button and click Next to navigate to the location of the

Word document and select it. After setting up a Submit method in the New Form Assistant, Designer

converts the Word document. Paragraphs are converted into subforms automatically and fields are

given a light gray fill to make them easily identifiable. 

Microsoft InfoPath forms can also be imported in the same manner. When importing InfoPath forms

you can choose which view to use from the File Import Options dialog (see Figure 46.14).

Form Properties and Settings
Basic form details can be accessed and edited from the File, Form Properties menu option. A form

name, creator name, form version, and date of creation can be entered to help you keep track of

updates to your forms. You can also use the Properties dialog to set up password and security per-

missions. For example, you can make the form unprintable or disable all editing except for filling in

the form fields.
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Figure 46.13
With the Hierarchy palette you can
see and organize the objects in
your form.
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Setting Up a Tabbing Order
If you do a lot of form filling you may already be familiar with using the Tab key to navigate from

one field to the next instead of using a mouse to click on fields. Designer enables you to determine

the order in which you or your peers can navigate through your forms.

To set up a tabbing order, choose View, Tab Order. A numbered tag appears next to each object in

your form. These tags show the current tab order. Hold the Shift key and click on the object you

want to be the first in the tab sequence. Next, release the Shift key and continue clicking on objects

in the order you want them to be in the sequence. When you are finished, choose View, Tab Order

one more time. That’s it. Your new tabbing order is set (see Figure 46.15).
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Figure 46.14
Select the InfoPath View you want
to use from the File Import
Options dialog.

Figure 46.15
Changing the tabbing order is
easy with Designer.
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BARCODES AND CUSTOM OBJECTS
Besides the form objects shown in the Library’s Standard tab, Designer supports barcodes in over 30

formats with customizable settings through the Object palette. These barcodes can be used for tasks

such as form identification and version tracking. If you need to print barcodes on adhesive labels for

product identification, you can also use Designer for that task.

Custom objects are ready-to-use objects for common tasks like inserting dates; inserting survey

questions with set radio buttons; inserting preset address fields; inserting a list of countries; insert-

ing a list of all the U.S. states; inserting a page navigation bar with buttons for First Page, Next Page,

Previous Page, and Last Page; and more. 

You can also create and save your own custom objects and group them by project. To add a group,

click on the More button in the Library palette and select Add Group. After you enter a name for your

group, it shows as a new tab in the Library palette. To add a custom object to a group drag it to the

Library palette. A dialog pops up prompting you to enter a name for your object and the group where

you want it to appear in the Library palette (see Figure 46.16).
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Figure 46.16
You can create new groups in the
Library palette to keep your own
custom objects organized.

SUBSTITUTING AND EMBEDDING FONTS
When you open an existing form in Designer it looks in your computer for all the fonts that were used

to create it. If Designer fails to find any required font it displays a warning message and uses an

existing font as a temporary substitute. When you save the form, the substitute font is dumped and

the PDF maintains its original font data. You can choose to make this font substitution permanent by

choosing File, Save As and checking the Permanently Replace Unavailable Fonts check box in the

Save As dialog. Enabling the Embed Fonts check box in the same dialog prompts Designer to embed

all fonts used in the form that are not already embedded (see Figure 46.17).

How does Designer determine which fonts to use as substitutes? During installation, Designer cre-

ates an XML schema file named designer.xci in the C:\Program Files\Adobe\Adobe Acrobat

7.0\\Designer 7.0 folder that contains a basic substitution table. If you want or need to create a

custom substitution table you can do it not by editing this schema file (it’s recommended that it be

left untouched) but by editing another file created just for that purpose, ConvertPDF_FontMap.txt,

located in the same folder. 
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By default this file is empty and editing it is easy by using Notepad or any other ASCII text editor.

You can type a substitution list using the following syntax:

inputfont=Designerfont

where inputfont is the name of the font you want to substitute and Designerfont is the font to

use as the substitution. You can use asterisk (*) and question mark (?) wildcards in the names to

cover for any small variations in the font names. Thus, the entry

*Futur*=Arial

makes Designer use Arial whenever it finds a request for Futura or Future or Futurist. If you want to

use a general substitute for uncommon fonts you can use a wildcard like

*=Times New Roman

which tells Designer to use Times New Roman as a substitute for any font not found in the substitu-

tion list.

JAVASCRIPT INSIDE FORMS
Like Acrobat, Designer enables the use of JavaScript in its forms. In fact, Designer uses two different

scripting languages: Its own FormCalc is the main one, and JavaScript is a supporting language.

However, unlike Acrobat, Designer’s emphasis in the use of JavaScript is on the business side of

form management because it’s a part of LiveCycle, which is not a graphics suite but a business doc-

ument management solution. 

For example, if you use Designer to create invoice forms, you could use JavaScript to have the form

query a database and retrieve current prices for items in the invoice and then calculate and display

the totals. 

Implementing JavaScript opens a whole new perspective for Designer users. To learn more about

using JavaScript and/or FormCalc with Designer, visit http://partners.adobe.com/public/developer/

livecycle/devcenter.html.
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Figure 46.17
Unlike Acrobat, no subsetting is
available when embedding fonts
in Designer.
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